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1.   This document is provided for reference purposes only so that Renesas customers may select the appropriate  
      Renesas products for their use. Renesas neither makes warranties or representations with respect to the  
      accuracy or completeness of the information contained in this document nor grants any license to any 
      intellectual property rights or any other rights of Renesas or any third party with respect to the information in 
      this document. 
2.   Renesas shall have no liability  for damages or infringement of any intellectual property or other rights arising 
      out of the use of any information in this document, including, but not limited to, product data, diagrams, charts, 
      programs, algorithms, and application circuit examples.
3.   You should not use the products or the technology described in this document for the purpose of military  
      applications such as the development of weapons of mass destruction or for the purpose of any other military 
      use. When exporting the products or technology described herein, you should follow the applicable export 
      control laws and regulations, and procedures required by such laws and regulations.
4.   All information included in this document such as product data, diagrams, charts, programs, algorithms, and 
      application circuit examples, is current as of the date this document is issued. Such information, however,  is 
      subject to change without any prior notice. Before purchasing or using any Renesas products listed in this 
      document, please confirm the latest product information  with a Renesas sales office. Also, please pay regular 
      and careful attention to additional and different information to be disclosed by Renesas such as that disclosed 
      through our website. (http://www.renesas.com )
5.   Renesas has used reasonable care in compiling the information included in this document, but Renesas 
      assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information 
      included in this document.
6.   When using or otherwise relying on the information in this document, you should evaluate the information in 
      light of the total system before deciding about the applicability of such information to the intended application.  
      Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any 
      particular application and specifically disclaims any liability arising out of the application and use of the 
      information in this document or Renesas products.  
7.   With the exception of products specified by Renesas as suitable for automobile applications, Renesas 
      products are not designed, manufactured or tested for applications or otherwise in systems the failure or 
      malfunction of which may cause a direct threat to human life or create a risk of human injury or which require 
      especially high quality and reliability such as safety systems, or equipment or systems for transportation and 
      traffic, healthcare, combustion control, aerospace and aeronautics, nuclear power, or undersea communication 
      transmission. If you are considering the use of our products for such purposes, please contact a Renesas 
      sales office beforehand. Renesas shall have no liability for damages arising out of the uses set forth above.
8.   Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:
        (1) artificial life support devices or systems
        (2) surgical implantations
        (3) healthcare intervention (e.g., excision, administration of medication, etc.)
        (4) any other purposes that pose a direct threat to human life
      Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who  
      elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas 
      Technology Corp., its affiliated companies and their officers, directors, and employees against any and all 
      damages arising out of such applications. 
9.   You should use the products described herein within the range specified by Renesas, especially with respect 
      to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
      characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or 
      damages arising out of the use of Renesas products beyond such specified ranges.
10. Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific 
      characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use 
      conditions. Please be sure to implement safety measures to guard against the possibility of physical injury, and 
      injury or damage caused by fire in the event of the failure of a Renesas product, such as safety design for 
      hardware and software including but not limited to redundancy, fire control and malfunction prevention, 
      appropriate treatment for aging degradation or any other applicable measures.  Among others, since the 
      evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or  
      system manufactured by you.  
11. In case Renesas products listed in this document are detached from the products to which the Renesas 
      products are attached or affixed, the risk of accident such as swallowing by infants and small children is very 
      high. You should implement safety measures so that Renesas products may not be easily detached from your 
      products. Renesas shall have no liability for damages arising out of such detachment.
12. This document may not be reproduced or duplicated, in any form, in  whole or in part, without prior written 
      approval from Renesas. 
13. Please contact a Renesas sales office if you have any questions regarding the information contained in this  
      document, Renesas semiconductor products, or if you have any other inquiries.

Notes regarding these materials
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IMPORTANT INFORMATION 

READ FIRST 

• READ this user's manual before using this emulator product. 

• KEEP the user's manual handy for future reference. 

Do not attempt to use the emulator product until you fully understand its mechanism. 

Emulator Product: 

     Throughout this document, the term "emulator product" shall be defined as the following 
products produced only by Renesas Technology Corp. excluding all subsidiary products. 

• Emulator 
• User system interface cable 

The user system or a host computer is not included in this definition. 

Purpose of the Emulator Product:  

     This emulator product is a software and hardware development tool for systems employing the 
Renesas microcomputer.  This emulator product must only be used for the above purpose. 

Limited Applications:  

     This emulator product is not authorized for use in MEDICAL, atomic energy, aeronautical or 
space technology applications without consent of the appropriate officer of a Renesas sales 
company.  Such use includes, but is not limited to, use in life support systems.  Buyers of this 
emulator product must notify the relevant Renesas sales offices before planning to use the product 
in such applications. 

Improvement Policy:  

     Renesas Technology Corp. (including its subsidiaries, hereafter collectively referred to as 
Renesas) pursues a policy of continuing improvement in design, performance, and safety of the 
emulator product.  Renesas reserves the right to change, wholly or partially, the specifications, 
design, user's manual, and other documentation at any time without notice. 

Target User of the Emulator Product:  

     This emulator product should only be used by those who have carefully read and thoroughly 
understood the information and restrictions contained in the user's manual. Do not attempt to use 
the emulator product until you fully understand its mechanism. 

     It is highly recommended that first-time users be instructed by users that are well versed in the 
operation of the emulator product. 
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LIMITED WARRANTY 

      Renesas warrants its emulator products to be manufactured in  
 accordance with published specifications and free from defects in  
 material and/or workmanship. Renesas, at its option, will replace any  
 emulator products returned intact to the factory, transportation charges  
 prepaid, which Renesas, upon inspection, shall determine to be defective  
 in material and/or workmanship. The foregoing shall constitute the sole  
 remedy for any breach of Renesas’ warranty. See the Renesas warranty  
 booklet for details on the warranty period. This warranty extends only  
 to you, the original Purchaser. It is not transferable to anyone who  
 subsequently purchases the emulator product from you. Renesas is not  
 liable for any claim made by a third party or made by you for a third  
 party. 

DISCLAIMER 

      RENESAS MAKES NO WARRANTIES, EITHER EXPRESS OR  
 IMPLIED, ORAL OR WRITTEN, EXCEPT AS PROVIDED  
 HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,  
 WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY,  
 FITNESS FOR ANY PARTICULAR PURPOSE OR USE, OR  
 AGAINST INFRINGEMENT OF ANY PATENT. IN NO EVENT  
 SHALL RENESAS BE LIABLE FOR ANY DIRECT, INCIDENTAL  
 OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR  
 LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE  
 EMULATOR PRODUCT, THE USE OF ANY EMULATOR  
 PRODUCT, OR ITS DOCUMENTATION, EVEN IF ADVISED  
 OF THE POSSIBILITY OF SUCH DAMAGES.  EXCEPT AS  
 EXPRESSLY STATED OTHERWISE IN THIS WARRANTY,  
 THIS EMULATOR PRODUCT IS SOLD "AS IS ", AND YOU  
 MUST ASSUME ALL RISK FOR THE USE AND RESULTS  
 OBTAINED FROM THE EMULATOR PRODUCT. 
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State Law:  

     Some states do not allow the exclusion or limitation of implied warranties or liability for 
incidental or consequential damages, so the above limitation or exclusion may not apply to you.  
This warranty gives you specific legal rights, and you may have other rights which may vary from 
state to state. 

The Warranty is Void in the Following Cases:  

     Renesas shall have no liability or legal responsibility for any problems caused by misuse, 
abuse, misapplication, neglect, improper handling, installation, repair or modifications of the 
emulator product without Renesas’ prior written consent or any problems caused by the user 
system.   

All Rights Reserved:  

     This user's manual and emulator product are copyrighted and all rights are reserved by 
Renesas.  No part of this user's manual, all or part, may be reproduced or duplicated in any form, 
in hard-copy or machine-readable form, by any means available without Renesas’ prior written 
consent. 

Other Important Things to Keep in Mind:  

1. Circuitry and other examples described herein are meant merely to indicate the characteristics 
and performance of Renesas’ semiconductor products. Renesas assumes no responsibility for 
any intellectual property claims or other problems that may result from applications based on 
the examples described herein. 

2. No license is granted by implication or otherwise under any patents or other rights of any third 
party or Renesas.  

Figures:  

     Some figures in this user's manual may show items different from your actual system. 

Device names:  

     This user’s manual uses SHxxxx as an example of the device names. 

Limited Anticipation of Danger:  

     Renesas cannot anticipate every possible circumstance that might involve a potential hazard.  
The warnings in this user's manual and on the emulator product are therefore not all inclusive.  
Therefore, you must use the emulator product safely at your own risk. 
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SAFETY PAGE 

READ FIRST 

• READ this user's manual before using this emulator product. 

• KEEP the user's manual handy for future reference. 

Do not attempt to use the emulator product until you fully understand its mechanism. 

DEFINITION OF SIGNAL WORDS 

 This is the safety alert symbol.  It is used to alert you to potential personal  
 injury hazards.  Obey all safety messages that follow this symbol to avoid  
 possible injury or death. 

DANGER  DANGER indicates an imminently hazardous situation which, if not  
 avoided, will result in death or serious injury. 

WARNING  WARNING indicates a potentially hazardous situation which, if not  
 avoided, could result in death or serious injury. 

CAUTION  CAUTION indicates a potentially hazardous situation which, if not  
 avoided, may result in minor or moderate injury. 

CAUTION  CAUTION used without the safety alert symbol indicates a  
 potentially hazardous situation which, if not avoided, may result  
 in property damage. 

NOTE emphasizes essential information. 



  Rev. 1.00  Nov. 26, 2007  Page V of VI 

  REJ10J1766-0100 

WARNING 
  Observe the precautions listed below.  Failure to do so  
 will result in a FIRE HAZARD and will damage the user  
 system and the emulator product or will result in  
 PERSONAL INJURY.  The USER PROGRAM will be  
 LOST.   

 1. Do not repair or remodel the emulator product by  
  yourself for electric shock prevention and quality  
  assurance. 

 2. Always switch OFF the host computer and user system  
       before connecting or disconnecting any CABLES or  
  PARTS. 

 3. Connect the connectors in the user system and in the  
      user interface cable by confirming the correct direction. 
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Warnings on Emulator Usage 

Be sure to read and understand the warnings below before using this emulator. Note that these are 
the main warnings, not the complete list. 

WARNING
 

  Always switch OFF the host computer and user system 
before connecting or disconnecting any CABLES or PARTS.  
  Failure to do so will result in a FIRE HAZARD and will 
damage the user system and the emulator product or will 
result in PERSONAL INJURY.  The USER PROGRAM will be 
LOST.  

 

CAUTION 
  Place the host computer and user system so that no 
cable is bent or twisted. A bent or twisted cable will impose 
stress on the user interface leading to connection or contact 
failure.  
  Make sure that the host computer and the user system 
are placed in a secure position so that they do not move 
during use nor impose stress on the user interface. 

 

 



 

 Rev. 1.00  Nov. 26, 2007  Page i of x 

                                                                                     REJ10J1766-0100 

Introduction 

The High-performance Embedded Workshop is a powerful development environment for 
embedded applications targeted at Renesas microcontrollers. The main features are: 

• A configurable build engine that allows you to set-up compiler, assembler and linker options 
via an easy to use interface. 

• An integrated text editor with user customizable syntax coloring to improve code readability. 

• A configurable environment to run your own tools. 

• An integrated debugger which allows you to build and debug in the same application. 

• Version control support. 
 
The High-performance Embedded Workshop has been designed with two key aims; firstly to 
provide you, the user, with a set of powerful development tools and, secondly, to unify and present 
them in a way that is easy to use.  
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About This Manual 

This manual describes preparation before using the emulator, emulator functions, debugging 
functions specific to the emulator, tutorial, and emulator's hardware and software specifications. 

Refer to the High-performance Embedded Workshop User's Manual for details on the information 
on the basic usage of the High-performance Embedded Workshop, customization of the 
environment, build functions, and debugging functions common to each High-performance 
Embedded Workshop product. 

This manual does not intend to explain how to write C/C++ or assembly language programs, how 
to use any particular operating system or how best to tailor code for the individual devices. These 
issues are left to the respective manuals. 

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.  

Visual SourceSafe is a trademark of Microsoft Corporation. 

IBM is a registered trademark of International Business Machines Corporation.  

All brand or product names used in this manual are trademarks or registered trademarks of their 
respective companies or organizations. 

 

Document Conventions 

This manual uses the following typographic conventions: 

Table 1 Typographic Conventions 

Convention Meaning 

[Menu->Menu Option] Bold text with ‘->’ is used to indicate menu options  
(for example, [File->Save As...]). 

FILENAME.C Uppercase names are used to indicate filenames. 

“enter this string” Used to indicate text that must be entered (excluding the “” quotes). 

Key + Key Used to indicate required key presses. For example, CTRL+N means 
press the CTRL key and then, whilst holding the CTRL key down, 
press the N key. 

 
(The “how to” symbol) 

When this symbol is used, it is always located in the left hand margin. 
It indicates that the text to its immediate right is describing  “how to” 
do something. 

 

 



 

 Rev. 1.00  Nov. 26, 2007  Page iii of x 

                                                                                     REJ10J1766-0100 

User Registration 

When you have purchased the emulator represented in this user's manual, be sure to register it. As 
the H/W Tool Customer Registration Sheet is included with this product, fill it in and send the 
same contents to the following address by an email. Your registered information is used for only 
after-sale services, and not for any other purposes. Without user registration, you will not be able 
to receive maintenance services such as a notification of field changes or trouble information. So 
be sure to carry out the user registration. 

For more information about user registration, send an email to the following address. 

regist_tool@renesas.com 
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Section 1   Overview 

The High-performance Embedded Workshop provides a graphical user interface that eases the 
development and debugging of applications written in the C/C++ programming languages or 
assembly language for Renesas microcomputers. Its aim is to provide a powerful yet intuitive way 
of accessing, observing and modifying the debugging platform on which the application is 
running. 

The E10A-USB Multi emulator (hereafter referred to as the emulator) is a support tool for 
developing the hardware and software of application systems running on Renesas original 
microcomputers. 

The main unit of the emulator is connected, through the dedicated debugging interface, to the user 
system.  The user system can be debugged under the conditions similar to the actual application 
conditions.  The emulator enables debugging anywhere indoors or out.  The host computer for 
controlling the emulator must be an IBM PC compatible machine with USB 1.1/2.0 (Full-Speed).  

Figure 1.1 shows the system configuration using the emulator. 

High-performance 
Embedded Workshop

CD-R

RENESAS

USB I/F

E10A

User system interface cable
(38 pins or 14 pins)

Multi-core microcomputer

Host computer (with USB interface)

Connected to 
the USB connector

Connected to 
the USB connector

E10A-USB Multi emulator

USB cable (1.5 m)

User system connector

User system  

Figure 1.1   System Configuration with the Emulator 
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The emulator provides the following features: 

• Excellent cost-performance emulator 

Compactness and connection to the USB are implemented. 

• Realtime emulation 

Realtime emulation of the user system is enabled at the maximum operating frequency of the 
CPU. 

• Excellent operability 

Using the High-performance Embedded Workshop on the Microsoft® Windows® 2000, or 
Microsoft® Windows® XP operating system enables user program debugging using a pointing 
device such as a mouse.  The High-performance Embedded Workshop enables high-speed 
downloading of load module files. 

• Various debugging functions 

Various break and trace functions enable efficient debugging.  Breakpoints and break 
conditions can be set by the specific window, trace information can be displayed on a window, 
and command-line functions can be used. 

• Debugging of the user system in the final development stage 

The user system can be debugged under conditions similar to the actual application conditions. 

• Compact debugging environment 

When the emulator is used, a laptop computer can be used as a host computer, creating a 
debugging environment in any place. 

• AUD trace function* 

The AUD trace function enables realtime trace. 

Note: The AUD is an abbreviation of the Advanced User Debugger. Support for the AUD varies 
with the product. 
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1.1 Warnings 

CAUTION  
  READ the following warnings before using the emulator 
product. Incorrect operation will damage the user system and 
the emulator product. The USER PROGRAM will be LOST. 

1. Check all components against the component list after unpacking the emulator. 

2. Never place heavy objects on the casing. 

3. Protect the emulator from excessive impacts and stresses.  For details, refer to section 1.2, 
Environmental Conditions. 

4. When moving the host computer or user system, take care not to vibrate or damage it. 

5. After connecting the cable, check that it is connected correctly.  For details, refer to section 3, 
Preparation before Use. 

6. Supply power to the connected equipment after connecting all cables.  Cables must not be 
connected or removed while the power is on. 
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1.2 Environmental Conditions 

CAUTION  
  Observe the conditions listed in tables 1.1 and 1.2 when 
using the emulator.  Failure to do so will cause illegal 
operation in the user system, the emulator product, and the 
user program. 

Table 1.1   Environmental Conditions 

Item Specifications 

Temperature Operating: +10°C to +35°C 
Storage: –10°C to +50°C 

Humidity Operating: 35% RH to 80% RH,  no condensation 
Storage: 35% RH to 80% RH,  no condensation 

Vibration Operating: 2.45 m/s2 max. 
Storage: 4.9 m/s2 max. 
Transportation: 14.7 m/s2 max. 

Ambient gases No corrosive gases may be present 
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Table 1.2 lists the acceptable operating environments. 

Table 1.2   Operating Environments 

Item Description 

Host computer Built-in Pentium® III or higher-performance CPU (1 GHz or higher 
recommended); IBM PC or compatible machine with USB 1.1/2.0 (Full-
Speed). 

Operating system Windows® 2000 or Windows® XP 

Minimum memory 
capacity 

128 Mbytes or more (512 Mbytes recommended) 

Hard-disk capacity Installation disk capacity: 600 Mbytes or more.  (Prepare an area at 
least double the memory capacity (four-times or more recommended) 
as the swap area.) 

Pointing device such as 
mouse 

Connectable to the host computer; compatible with Windows® 2000 or 
Windows® XP. 

Display Monitor resolution: 1024 x 768 or higher 

Power voltage 5.0 ± 0.25 V (USB-bus power type) 

Current consumption HS0005KCU04H: 500 mA (max.) 

CD-ROM drive Required to install the High-performance Embedded Workshop for the 
emulator or refer to the emulator user’s manual. 

 

1.3 Components 

Check that all of the components are present when unpacking the product.  For details on the 
emulator components, refer to section 1.1 in the additional document, Supplementary Information 
on Using the SHxxxx.  If all of the components are not present, contact your nearest Renesas sales 
office or contact center (csc@renesas.com).
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Section 2   Emulator Functions 

This section describes the emulator functions.  They differ according to the device supported by 
the emulator.  For the usage of each function, refer to section 6, Tutorial. 

2.1 Overview 

Table 2.1 gives a functional overview of the emulator. 

For details on the functions of each product, refer to the online help. 
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Table 2.1   Emulator Functions 

No. Item Function 

1 User program execution 
function 

• Executes a program with the operating frequency within a 

range guaranteed by devices. 

• Reset emulation 

• Step functions: 
Single step (one step: one instruction) 
Source-level step (one step: one-line source) 

Step over (a break did not occur in a subroutine) 
Step out (when the PC points to a location within a 
subroutine, execution continues until it returns to the calling 

function) 

• Synchronized functions: 

      Synchronized execution functions.(Execution at the same 
time with synchronizing CPU0 and CPU1.) 

      Synchronized step functions. (All of the CPUs execute with 
synchronizing the one of stepping for the CPU.) 

      Synchronized break functions. (All of the CPUs break by 

synchronizing the one of a break for the CPU.) 

2 Reset function • Issues a power-on reset from the High-performance 
Embedded Workshop to the device during break. 

3 Trace functions • Trace function incorporated in the device 

• AUD trace: 

Branch trace or memory access trace 

• Memory output function of trace data 

4 Break functions • Hardware break condition (conditions and the number of 
conditions differ according to the device) 

• PC break condition (255 points) 

• Forced break function 
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Table 2.1   Emulator Functions (cont) 

No. Item Function 

5 Performance 
measurement function 

• Uses a counter in the device to measure the number of 

cycles that passes during point-to-point execution. 

6 Memory access functions • Downloading to RAM 

• Downloading to flash memory 

• Single-line assembly 

• Reverse assembly (disassembly) 

• Reading of memory 

• Writing to memory 

• Automatic updating of a display of selected variables during 
user program execution 

• Fill 

• Search 

• Move 

• Copy 

• Monitor (physical address) 

7 General/control register 
access function 

• Reads or writes the general/control registers. 

8 Internal I/O register 
access function 

• Reads or writes the internal I/O registers.* 

9 Source-level debugging 
function 

• Various source-level debugging functions. 

10 Command line function • Supports command input. 

• Batch processing is enabled when a file is created by 
arranging commands in input order. 

11 Help function • Describes the usage of each function or command syntax 
input from the command line window. 

Note: The [IO] window displays the contents defined in [SHxxxx.io]. Editing those contents adds 
or deletes the registers to be displayed. For the contents to be described as [SHxxxx.io], 
refer to reference 5, I/O File Format, in the High-performance Embedded Workshop V.4.00 
User’s Manual.  
The following directory contains [SHxxxx.io] (xxxx means the name of emulator device 
group.):  
<High-performance Embedded Workshop folder>:  
\Tools\Renesas\DebugComp\Platform\E10A-USBM\xxxx\IOFiles 

 

The specific functions of the emulator are described in the next section. 
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2.2 Trace Functions 

The emulator has two trace functions. 

2.2.1 Internal Trace Function 

The branch source and branch destination addresses, mnemonics, operands, and source lines are 
displayed.  This function uses the trace buffer built into the device. 

Notes: 1. The number of branch instructions that can be acquired by a trace differs according to 
the product.  For the number that can be specified for each product, refer to the online 
help. 

 2. The internal trace function is not supported for all products.  For details on the 
specifications of each product, refer to the online help. 

 3. The internal trace function is extended for some products.  For details on the 
specifications of each product, refer to the online help. 

2.2.2 AUD Trace Function 

This is the large-capacity trace function that is enabled when the AUD pins are connected to the 
emulator.  If an event occurs to acquire a trace, trace information is output in realtime from the 
AUD pins. 

When a set of the branch source and branch destination instructions is one branch, the maximum 
amount of information acquired by a trace is 32,767. 

(1) Trace acquisition event 

The following events can be acquired by the AUD trace function. 

(a) Branch generation information 

The branch source and branch destination addresses are acquired. 

(b) Memory access information within the specified range 

Memory access in the specified range can be acquired by trace. 

Two memory ranges can be specified for channels A or B.  The read, write, or read/write cycle 
can be selected as the bus cycle for trace acquisition. 

This function is called the window trace function. 
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(c) Software trace 

When a specific instruction is executed, the PC value at execution and the contents of one 
general register are acquired by trace.  Describe the Trace(x) function (x is a variable name) to 
be compiled and linked beforehand.  For details, refer to the SHC/C++ compiler manual. 

When the load module is loaded on the emulator and a valid software trace function is 
executed, the PC value that has executed the Trace(x) function, the variable for x, and the 
source lines are displayed. 

Note: The types of events acquired by a trace differ depending on the product.  For details on the 
specifications of each product, refer to the online help. 

 
(2) Trace acquisition mode 

The AUD trace function has the following modes to acquire a trace. 

Table 2.2 shows the AUD trace acquisition mode that can be set in each trace function. 

Table 2.2   AUD Trace Acquisition Mode 

Type Mode Description 

Continuous 
trace occurs 

Realtime trace When the next branch occurs while the trace information is 
being output, all the information may not be output.  The user 
program can be executed in realtime, but some trace 
information will be lost. 

 Non realtime 
trace 

When the next branch occurs while the trace information is 
being output, the CPU stops operations until the information 
is output.  The user program is not executed in realtime. 

Trace buffer 
full 

Trace continue This function overwrites the latest trace information to store 
the oldest trace information. 

 Trace stop After the trace buffer becomes full, the trace information is no 
longer acquired.  The user program is continuously executed. 
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(3) Trace display contents 

When the program breaks, the following trace results are displayed in the [Trace] window. 

• PTR: The trace-buffer pointer (+0 from the last instruction to have been executed) 

• IP: Indicates the number of cycles that have elapsed since the latest trace information was 
gathered.  For branch instructions, the branch source and destination are counted together as 
one. 

• Type: Displays the type of trace acquisition information. 

• Address: Displays the addresses from which the trace data was acquired. 

• Data: Displays the data acquired in the trace.  For information without data, displays 
‘********’. 

• Instruction, Source, Label: Displays the mnemonic of the instruction at the trace acquisition 
address, along with the corresponding source code and label information.  Double-clicking on 
the [Source] column moves the cursor to the corresponding position in the [Editor] window. 

 
The Type, Address, and Data columns have different meanings according to the type of AUD 
trace that has been selected. 

Table 2.3   [Trace Window] Display Contents 

Trace Type Type Column Address Column Data Column 

Branch trace BRANCH Branch source address No display 

 DESTINATION Branch destination address No display 

Window trace*1 MEMORY Memory access address Memory access data 

Software trace*1 S_TRACE Trace(x) function execution 
address 

Variable x data 

Data lost*1, *2 LOST No display No display 

CPU wait 
generation*1, *2 

CPU-WAIT No display No display 

Notes: 1. Not displayed in the internal trace. 
2. According to the device being debugged, there may be no output for the [Lost] or 

[CPU-WAIT] type. In such a case, it is not possible to clarify whether the trace data 
was not output in time or the CPU generated a wait state for the output trace data. 
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The following items will be displayed, according to the device to be debugged. 

For specifications of the individual products, refer to the additional document, Supplementary 
Information on Using the SHxxxx, or the online help. 

• PTR: The trace-buffer pointer (+0 from the last instruction to have been executed) 

• IP: Indicates the number of cycles that have elapsed since the latest trace information was 
gathered.  For branch instructions, the branch source and destination are counted together as 
one. 

• Master: Type of bus master that accessed the memory. 

• Type: Displays the type of trace acquisition information. 

• Branch Type: Branch type (only displayed for a branch trace) 
For an AUD trace, this item is only displayed if the PPC option has been enabled. 

• Bus: Displays which bus was accessed. 

• R/W: Displays whether the access involved reading or writing. 

• Address: Displays the addresses from which the trace data was acquired. 

• Data: Displays the data acquired in the trace. 

• PPC: Output from a performance counter 

• Instruction, Source, Label: Displays the mnemonic of the instruction at the trace acquisition 
address, along with the corresponding source code and label information.  Double-clicking on 
the [Source] column moves the cursor to the corresponding position in the [Editor] window. 

 
The Type, BUS, R/W, Address, and Data columns have different meanings according to the type 
of AUD trace that has been selected. 
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Table 2.4   [Trace Window] Display Contents 

Trace Type Type Column BUS Column R/W Column Address Column Data Column 

Branch trace BRANCH*1 No display No display Branch source 
address*1 

No display 

 DESTINATION No display No display Branch destination 
address 

No display 

Memory-
range access 
trace 

MEMORY No display Read/write Memory access 
address 

Memory 
access data*1 

Software 
trace 

S_TRACE No display No display Trace(x) function 
execution address 

Variable x 
data 

System bus 
trace 

MEMORY No display Read/write Memory access 
address 

Memory 
access data 
(write only)*1 

Data lost*2 LOST No display No display No display No display 

CPU wait 
generation*2 

CPU-WAIT No display No display No display No display 

Notes: 1. Not displayed when the PPC option is in use. 

 2. According to the device being debugged, there may be no output for the [Lost] or 
[CPU-WAIT] type. In such a case, it is not possible to clarify whether the trace data 
was not output in time or the CPU generated a wait state for the output trace data. 

2.2.3 Memory Output Function of Trace Data 

In some devices to be debugged, trace data can be written to the specified memory range.  The 
data is read from the memory range written in the [Trace] window and the result is then displayed. 

Note: Do not specify the program area as the memory in the specified range is overwritten. 

2.2.4 Useful Functions of the [Trace] Window 

The trace window provides the following useful functions. 

(1) Searches for the specified data. 

(2) Extracts the specified data. 

(3) Filters and displays again the specified data. 

(4) Supplements the information from the branch destination address to the next branch source 
address. 

 
For the usage of those functions, refer to section 5.6, Viewing the Trace Information. 
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(5) Changes the trace settings during user program execution. 

In some devices to be debugged, trace settings can be changed during user program execution.  
For details on the specifications of each product, refer to the online help. 

2.3 Break Function 

The emulator has the following three break functions. 

(1) Hardware break function 

Uses a break controller incorporated in the device. 

The access address, instruction fetch address, data, or bus cycle condition can be set.  The 
logical address is the address condition. 

This function can be also set from the [Event] column in the [Editor] or [Disassembly] window.  
For the setting, refer to section 5.2, Downloading a Program. 

Note: In some devices to be debugged, hardware break settings can be changed during user 
program execution.  For details on the specifications of each product, refer to the online 
help. 

(2) PC break function (BREAKPOINT) 

Breaks when the dedicated instruction at the specified address that has been replaced is 
executed.  This function cannot be set at a place other than RAM or internal flash memory area 
since a memory write occurs. 

It can also be set when the [S/W breakpoint] column for the line to be set is double-clicked in 
the [Editor] or [Disassembly] window. 

(3)  Forced break function 

Forcibly breaks the user program. 

2.4 Performance Measurement Function 

The emulator has a following performance measurement function. 

2.4.1 Function for Measuring the Number of Cycles from Point to Point 

This function applies a counter in the device to measure the number of cycles from one specified 
condition being satisfied until a next specified condition is satisfied. 

Not only the number of cycles but also various items such as the number of cache misses or of 
TLB misses can be measured according to the supported devices. 
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This function is hereafter called the performance measurement function or PA1. 

Note: Items to be measured differ according to the product and some products do not support 
this function.  For details on the specifications of each product, refer to the online help. 

 

2.5 Memory Access Functions 

The emulator has the following memory access functions. 

(1) Memory read/write function 

[Memory] window: The memory contents are displayed in the window. Only the amount 
specified when the [Memory] window is opened can be read.  Since there is 
no cache in the emulator, read cycles are always generated.  If the memory is 
written in the [Memory] window, read cycles in the range displayed in the 
[Memory] window will occur for updating the window.  When the [Memory] 
window is not to be updated, change the setting in [Lock Refresh] from the 
popup menu. 

me command: A command line function that reads or writes the specified amount of 
memory at the specified address. 

(2) User program downloading function 

A load module registered in the workspace can be downloaded.  Such module can be selected 
from [Download Module] in the [Debug] menu.  Downloading is also possible by a popup menu 
that is opened by right-clicking on the mouse at the load module in the workspace.  The user 
program is downloaded to the RAM or internal flash memory. 

When downloading to the flash memory that has not been within the MPU, select [Emulator] from 
the [Setup] menu, open the [Configuration] window, and perform required settings on the 
[Loading flash memory] page. 

This function also downloads information required for source-level debugging such as debugging 
information. 

(3) Memory data uploading function 

The specified amount of memory from the specified address can be saved in a file. 

(4) Memory data downloading function 

The memory contents saved in a file can be downloaded.  Select [Load] from the popup menu in 
the [Memory] window. 
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(5) Displaying the variable contents 

The variable contents specified in the user program are displayed. 

(6) Monitoring function 

In some devices to be debugged, memory contents can be monitored during user program 
execution.  For details on the specifications of each product, refer to the online help. 

(7) Other memory operation functions 

Other functions are as follows: 

• Memory fill 

• Memory copy 

• Memory save 

• Memory verify 

• Memory search 

• Internal I/O display 

• Cache table display and edit (only for devices incorporating caches) 

• TLB table display or edit (only for devices incorporating MMU) 

• Displaying label and variable names and their contents 
 
For details, refer to the online help. 

Notes:  

1.  Memory access during user program execution: 
When memory is accessed from the memory window, etc. during execution of the 
user program, execution stops for the memory access and is then resumed.  Therefore, 
realtime emulation cannot be performed. 
 

The stopping time of the user program is as follows: 

Environment: 

       Host computer: 3 GHz (Pentium® 4)  

       SH7265: CPU clock 66.6 MHz 

       JTAG clock: 2.5 MHz  

  When a one-byte memory is read from the command-line window, the stopping time 
will be about 8 ms. 

2. Memory access during user program break: 
The program can also be downloaded for the flash memory area by the emulator.  
Other memory write operations are enabled for the RAM area and the internal flash 
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memory.  Therefore, an operation such as memory write or BREAKPOINT should be 
set only for the RAM area and the internal flash memory.  When the memory area can 
be read by the MMU, do not perform memory write, BREAKPOINT setting, or 
downloading. 

3. Cache operation during user program break: 
When cache is enabled in the device incorporating a cache, the emulator accesses the 
memory by the following methods: 
•  At memory write: Writes through the cache, then writes to the memory or uses the 
OCBWB instruction. 
•  At memory read: Does not change the cache write mode that has been set. 
•  At memory verify: Disables the cache for verification read. 
Therefore, when memory read or write is performed during user program break, the 
cache state will be changed. 
In some devices to be debugged, the emulator accesses the memory by the following 
methods: 
•  At memory write: Writes to the cache, then issues an external single write. The 
LRU is not updated. 
•  At memory read: Reads memory from the cache. The LRU is not updated. 

 

2.6 Stack Trace Function 

The emulator uses the information on the stack to display the names of functions in the sequence 
of calls that led to the function to which the program counter is currently pointing.  This function 
can be used only when the load module that has the Dwarf2-type debugging information is loaded.  
For the usage of this function, refer to section 6.20, Stack Trace Function. 

2.7 User-interrupt Open Function during User Program Break 

Some devices to be debugged open all interrupts while executing emulation to users. During a user 
program break, it is possible to specify the mode whether or not the interrupt processing is 
executed. 

2.8 Online Help 

An online help explains the usage of each function or the command syntax that can be entered 
from the command line window. 

Select [Emulator Help] from the [Help] menu to view the emulator help.
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Section 3   Preparation before Use 

3.1 Emulator Preparation 

Unpack the emulator and prepare it for use as follows: 

WARNING 
  READ the reference sections shaded in figure 3.1 before 
using the emulator product.  Incorrect operation will damage 
the user system and the emulator product. The USER 
PROGRAM will be LOST. 

Section 3

Section 4

Input the user system reset signal

Unpack the emulator

Check the components against the component list

Start the High-performance Embedded Workshop

Turn on the user system

Component list

When the emulator
is used first.

When the emulator
is used for second
time or later.

Reference

Set up the emulator
- Install the emulator's software
  (Check the components and register the user information.)
- Insert the emulator
- Set up the main unit of the emulator

 

Figure 3.1   Emulator Preparation Flow Chart 
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3.2  Emulator Hardware Configuration 

As shown in figure 3.2, the emulator consists of an emulator, a USB cable, and a user system 
interface cable. The emulator is connected to the host computer via USB 1.1, and also to the USB 
port conforming to USB 2.0. 

 

Figure 3.2   Emulator Hardware Configuration (when the 38-pin Type Cable is Used) 
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The names of each section of the emulator are explained next. 

Emulator Top View: 

 

Figure 3.3   Emulator Top View 

(a) E10A-USB Multi logo plate: A black plate is dedicated for the emulator is provided to be 
easily distinguished from other E-series emulators. 

(b) ACTION LED: A circled LED. Marked ‘ACT’. When this LED is lit, the E10A-USB 
Multi control software is in operation. 

(c) RUN LED: Marked ‘1’. When this LED is lit, the user program is in operation. 

(d) ACT LED Marked ‘2’. When this LED is lit, the E10A-USB Multi is connecting 
to the micro computer. 
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(e) Core switch LED Marked ‘3’. When this LED is lit, the E10A-USB Multi switches the 
micro computer to be controled. 

(f) UVCC LED Marked ‘4’. When this LED is lit, the E10A-USB Multi is supplied  
the UVCC . 

(g) Host connector: Marked ‘ ’. A connector for the host computer is provided at the 
side of this mark. 

(h) User connector: Marked ‘USER I/F’. A connector for the user system interface cable 
is provided at the side of this mark. 

. 

Note: Even if the LED is not lit, the USB is not disconnected or malfunctioned. 

Emulator Host-side View: 

 

Figure 3.4   Emulator Host-side View 

(a) Host-side connector: A USB connector for the host computer. Be sure to connect the 
provided USB cable. 
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Emulator User-side View: 

 

Figure 3.5   Emulator User-side View 

(a) User-side connector: A user system interface cable is connected. 
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Emulator Bottom View: 

(a)

 MODEL : HS0005KCU04H 

SERIAL No. : 00001A
This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
  (1) This device may not cause harmful interference, and
  (2) This device must accept any interference received, including

interference that may cause undesired operation.

MADE IN JAPAN

 

Figure 3.6   Emulator Bottom View 

(a) Label for product management: The serial number, revision, and safety standard, etc. of the 
emulator are written to. The contents differ depending on the 
time when you purchased the product. 
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3.3 CD-R 

The root directory of the CD-R contains a setup program for installing the emulator’s software.  
The folders contain the files and programs listed below. 

Table 3.1   Contents of the CD-R Directories 

Directory Name Contents Description 

Dlls Microsoft® runtime library A runtime library for the High-performance 
Embedded Workshp.  The version is checked 
at installation and this library is copied to the 
hard disk as part of the installation process. 

Drivers E10A-USB Multi emulator 
driver 

USB drivers for the E10A-USB Multi emulator. 

Help Online help for the E10A-USB 
Multi emulator 

An online help file.  This is copied to the hard 
disk as part of the installation process. 

Manuals E10A-USB Multi emulator 
manuals 

E10A-USB Multi emulator user’s manuals.  
They are provided as PDF files. 

3.4 Installing Emulator’s Software 

Follow the cues given by the installation manager to install the software. 

The two of separated High-performance Embedded Workshop for the CPU0 and CPU1 will be needed to 

install. 

(1) Install the High-performance Embedded Workshop for the CPU0. Activate the 
HewInstMan.exe from the CD-R root directory, start up the installation manager and select the 
[Install the HEW to another directory], select the [change] button from the installation 
destination and name the folder name. Perform the Install following the Installation manager. 

(2) Install the High-performance Embedded Workshop for the CPU1. Activate the 
HewInstMan.exe from the CD-R root directory, start up the installation manager and select the 
[Install the HEW to another directory], select the [change] button from the installation 
destination and name the folder  name. Perform the Install following the Installation manager. 

Note: When a driver is installed in Windows® XP, a warning message on the Windows® logo 
test may be displayed, but it is not a problem.  Select [Continue Anyway] to proceed with 
driver installation. 
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3.5 Connecting the Emulator to the Host Computer 

This section describes how to connect the emulator to the host computer. For the position of each 
connector of the emulator, refer to section 3.2, Emulator Hardware Configuration. 

Notes: 1. When [Add New Hardware Wizard] is displayed, select the [Search for the best driver 
for your device. (Recommended)] radio button and then the [Specify a location] check 
box to select the path to be searched for drivers.  The location must be specified as 
<Drive>:\DRIVERS. (<Drive> is the CD drive letter.) 

 2. Be sure to install the software for the emulator before putting the emulator in place. 
 

WARNING
 

  Always switch OFF the emulator product and the user 
system before connecting or disconnecting any CABLES 
except for the USB interface cable.  Failure to do so will result 
in a FIRE HAZARD and will damage the user system and the 
emulator product or will result in PERSONAL INJURY.  
The USER PROGRAM will be LOST. 
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The emulator is connected to the host computer via the USB 1.1, and also to the USB port 
conforming to USB 2.0. Figure 3.7 shows the system configuration. 

USB cable (1.5 m)

E10A-USB Multi emulator
Host comuputer

 

Figure 3.7   System Configuration when Connecting the Emulator to the Host Computer 
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3.6 Connecting the Emulator to the User System 

Use the procedure below to connect the emulator to the user system with the user system interface 
cable, or to disconnect them when moving the emulator or the user system. 

1. Check that the host computer is turned off or the emulator is not connected to the host 
computer with the USB cable. 

2. Connect the user system interface cable to the user-side connector of the emulator. 

3. Connect the USB cable to the host-side connector of the emulator. 

Figure 3.8 shows the position of the connector. 

User interface cable connector

 

Figure 3.8   Position of the Connector 
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(1) The connector must be installed to the user system.  Table 3.2 shows the recommended 
connector for the emulator.  

Table 3.2   Recommended H-UDI Port Connector 

Connector Type Number Manufacturer Specifications 

14-pin connector 2514-6002 Minnesota Mining & 
Manufacturing Ltd. 

14-pin straight type 

36-pin connector DX10M-36S Hirose Electric Co., Ltd. Screw type 

 DX10M-36SE,  
DX10GM-36SE 

 Lock-pin type 

 

Notes: 1. When designing the 14-pin connector layout on the user board, do not place any 
components within 3 mm of the H-UDI port connector. 
When designing the 36-pin connector layout on the user board, do not connect other 
signal lines to the H-UDI port connector. 

 2. The H-UDI is an interface compatible with the Joint Test Action Group (JTAG) 
specifications. 

 
(2) The pin assignments of the connector are shown in section 2 in the additional document, 

Supplementary Information on Using the SHxxxx. 

(3) Connect pins 5 and GND bus read located in the center of the H-UDI port connector (when 
using the 38-pin user system interface cable) and pins 9, 10, 12, 13, and 14 (when using the 14-
pin user system interface cable) of the H-UDI port connector to GND firmly on the PCB. 
These pins are used as electrical GND and to monitor the connection of the H-UDI port 
connector. Note the pin assignments of the H-UDI port connector. 
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User System H-UDI Port Connector

User Interface Cable

 

Figure 3.9   Connecting the User System Interface Cable to the User System  
when the 38-pin Type Connector is Used 

User system

User system interface cable

H-UDI port connectorPin 1  

Figure 3.10   Connecting the User System Interface Cable to the User System  
when the 14-pin Type Connector is Used 
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CAUTION 
  Note that the pin number assignments of the connector 
differ from those of the connector manufacturer. 

Notes: 1. Connection of the signals differs depending on the package.  For details, refer to the 
MPU’s pin assignments. 

 2. The range of communication that the emulator operates at is different depending on 
the MPU used. 

 3. To connect the signals from the connector, refer to section 1 in the additional 
document, Supplementary Information on Using the SHxxxx. 

 4. When developing user systems, do not connect the TDI and TDO signals of the 
device to the boundary scan loop, or separate them by using a switch (figure 3.11). 
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SHxxxx

H-UDI

TDI TDO TDI TDOTDI TDO

H-UDI
port

JTAG
port

Boundary scan loop

User system

TDI: Test data input
TDO: Test data output
TAP: Test access port

IC

TAP

IC

TAP

IC

TAP

TDI

TDO

 

Figure 3.11   User System Example 
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3.7 Connecting System Ground 

WARNING
 

  Separate the frame ground from the signal ground at the 
user system.  Failure to do so will result in a FIRE HAZARD 
and will damage the user system and the emulator product or 
will result in PERSONAL INJURY. 

 
The emulator's signal ground is connected to the user system's signal ground. In the emulator, the 
signal ground and frame ground are connected. In the user system, connect the frame ground only; 
do not connect the signal ground to the frame ground (figure 3.12). 

If it is difficult to separate the frame ground from the signal ground in the user system, set the 
GND for DC power input (AC adapter) of the host computer and the frame ground of the user 
system as the same potential. If the GND potential is different between the host computer and the 
target system, an overcurrent will flow in the low-impedance GND line and thin lines might be 
burned. 

USB

E10A-USB Multi emulator

Logic Logic

Power 
supply

Host
computer

Signal ground

Signal ground
Signal

Signal ground

Signal

Frame ground

User system

 

Figure 3.12   Connecting System Ground 
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3.8 Interface Circuits in the Emulator 

Figures 3.13 and 3.14 show interface circuits in the emulator. Use them as a reference to 
determine the value of the pull-up resistance. 

Note: The 74LVC2G125 and 74LVC2T45 operate at VCC (1.8 to 5.0 V) from the H-UDI port 
connector. 
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Emulator control circuit H-UDI port connector
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Vcc
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A  Y
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Vcc

A  Y

10 kΩ

10 kΩ

10 kΩ

10 kΩ
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10 kΩ
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UVCC

TCK

ASEBRKAK

TDO

TMS

TDI

RESET

TRST

3.3V

74LVC2T45

74LVC2T45

74LVC2T45

74LVC2T45

74LVC2T45

74LVC2T45

B A
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A B

VccA VccB

A B

VccA VccB
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VccB VccA

B A

VccB VccA

A B

VccA VccB

 

Figure 3.13   Interface Circuits in the Emulator (H-UDI) 
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22 Ω
10 kΩ

UVCC_AUD

AUDATA[3:0]

22 ΩSN65LVDS33

SN65LVDS33

SN65LVDS33

SN65LVDS33

Reference voltage

10 kΩ

AUDCK

22 Ω
10 kΩ

AUDSYNC

22 Ω
10 kΩ

AUDATA[7:4]

Emulator control circuit H-UDI port connector

 

Figure 3.14   Interface Circuits in the Emulator (AUD)  
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3.9 Setting up the Emulator 

Set up the emulator’s firmware using the following procedures. The emulator will be set up for the 
first device group to be started. 

Note: Only one device group can be set up after the initial purchase of the emulator. To use the 
emulator for another device group after set up, purchase the license tool to add a device 
group. 

CAUTION  
  Do not disconnect the USB cable unless instructed to do 
so by an on-screen message. Incorrect operation will damage 
the emulator product. 
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3.10 System Check 

When the software is executed, use the procedure below to check that the emulator is connected 
correctly.  Here, use the workspace for a tutorial provided on the product. 

Refer to section 4, Preparations for Debugging, for the other activating method to create a new 
project or use an existing workspace. 

1. Connect the emulator to the host computer. 

2. Connect the user system interface cable to the connector of the emulator. 

3. Connect the user system interface cable to the connector in the user system. 

4. Double-click on the ”HEW2.exe” from the folder that is installed for CPU0 in section 3.4, 
Installing Emulator′s Software.  

5. [Welcome!] dialog box is displayed. 

 

Figure 3.15   [Welcome!] Dialog Box 

[Create a new project workspace] radio button: Creates a new workspace. 

[Open a recent project workspace] radio button: Uses an existing workspace and displays 
the history of the opened workspace. 

[Browse to another project workspace] radio button: Uses an existing workspace; this radio 
button is used when the history of the 
opened workspace does not remain. 

To use a workspace for the tutorial, select the [Browse to another project workspace] radio button 
and click the [OK] button. 
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When the [Open workspace] dialog box is opened, specify the following directory: 
<Drive where the OS has been installed>:\WorkSpace\Tutorial\E10A-USBM\SH2A-
DUAL\SH2A-DUAL\Tutorial_SH2A-DUAL\CPU0 

 

After the directory has been specified, select the following file and click the [Open] button. 

 

Figure 3.16   [Open The Workspace] Dialog Box 
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6. The [Select Emulator mode] dialog box is displayed. 

 

Figure 3.17   [Select Emulator mode] Dialog Box 

Select <name of the device in use>_CPU0 from the [Device] drop-down list box. The following 
item is selected in the [Mode] group box. 

⎯ E10A-USB Multi Emulator 

The E10A-USB Multi emulator for the specified MCU is activated. Debugging the 
program is enabled. 

7. The [Connecting] dialog box is displayed and connection of the emulator starts. 
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Figure 3.18   [Connecting] Dialog Box 

8. The dialog box shown in figure 3.19 is displayed if no product groups have been installed in 
the emulator at the time of purchase or if the SHxxxx license has been installed in the emulator 
but the emulator firmware has been set up for a different device group. The dialog box shown 
in figure 3.20 is displayed if an old version of the emulator firmware has been set up in the 
emulator. Clicking the [OK] button sets up the emulator firmware. 

 

Figure 3.19   Dialog Box to Confirm Setting up of the Emulator Firmware 
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Figure 3.20   Dialog Box to Confirm Updating of the SHxxxx Emulator Firmware 

CAUTION  
  The USB cable must not be disconnected until writing is 
complete. 
Early disconnection may damage the emulator. 

 

9. The dialog box shown in figure 3.21 is displayed. 

 

Figure 3.21   Dialog Box of the RESET Signal Input Request Message 

10. Power on the user system. 

11. Input the reset signal from the user system, and click the [OK] button. 

12. If no reset signal is detected, the following dialog box is displayed. 
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Figure 3.22   [Can not find /RESET signal] Dialog Box 

When the [Ignore] button is clicked, the emulator issues a reset in the CPU for initiation. 
However, this method is unavailable for some products. For details, refer to section 2.2, 
Specific Functions for the Emulator when Using the SHxxxx, in the additional document, 
Supplementary Information on Using the SHxxxx. 

 

13. If the "Connected" is displayed in the [Output] window of the High-performance Embedded 
Workshop for CPU0, starting up the emulator is completed. 

 

Figure 3.23   [Output] Window 

14. Double-click on the filename ”HEW.exe” in the folder that was installed for CPU0 in section 
3.4, Installing Emulator’s Software. 
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15.  The [Welcome!] dialog box is displayed. 

 

Figure 3.24   [Welcome!] Dialog box 

 

 

To use a workspace for the tutorial, select the [Browse to another project workspace] radio button 
and click the [OK] button. 

When the [Open workspace] dialog box is opened, specify the following directory: 
<Drive where the OS has been installed>:\WorkSpace\Tutorial\E10A-USBM\SH2A-
DUAL\SH2A-DUAL\Tutorial_SH2A-DUAL\CPU0 
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After specifying the directory, select the following file and click on the [Open] button  

 

Figure 3.25   [Open the workspace] Dialog box 

 

 

(16)  The [Select Emulator mode] dialog box is displayed. 

 

  

Figure 3.26   [Select Emulator mode] Dialog box 

 

Select <name of the device in use>_CPU1 from the [Device] drop-down list box. 
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The following item is selected in the [Mode] group box. 

⎯ E10A-USB Multi Emulator  

⎯ The E10A-USB Multi Emulator is activated for the selected device. Debugging of 
programs can proceed. 

 

(17) [Connecting] dialog box is displayed, and the emulator connection will be started up. 

 

  

Figure 3.27   [Connecting] Dialog box 

 

(18) If the ″Connected″ is displayed in the [Output] window of the High-performance 
Embedded Workshop for the CPU1, starting up for the emulator is completed. 
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Figure 3.28   [Output] Window 

 

Notes: If the emulator is not initiated, the following dialog boxes shown in figures 3.29 through 
3.35 will be displayed. 

 

(a) If the following dialog box is displayed and the method 11 above is unavailable, the 
power of the user system may not be input or the RESET signal may not be input to 
the device.  Check the input circuits for the power of the user system and the reset pin. 
 

 

Figure 3.29   [Can not find /RESET signal] Dialog Box 

(b) If the following dialog box is displayed, check that the H-UDI port connector on the 
user system is correctly connected. 
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Figure 3.30   [Check the connection] Dialog Box 

(c) If the following dialog box is displayed, the emulator’s firmware may not be set up 
correctly.  Set up the firmware of the device group that is used for the license tool. 
 

 

Figure 3.31   [The product currently connected] Dialog Box 

(d) If the following dialog box is displayed, the device may not correctly operate.  Check 
if there are reasons for illegal device operation. 
 

 

Figure 3.32   [COMMUNICATION TIMEOUT ERROR] Dialog Box 
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Figure 3.33   [INVALID ASERAM FIRMWARE!] Dialog Box 

 

Figure 3.34   [Error JTAG boot] Dialog Box 

 

(e) The following dialog box is displayed when the MCU cannot communicate with the 
emulator.  The MCU may not operate correctly; check the MCU settings. 
 

 

Figure 3.35   [Boot Failed!] Dialog Box 
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 2. If an incorrect driver has been selected, the following dialog box will appear. 
 

 

Figure 3.36   [Unable to restore the previous driver settings] Dialog Box 

 3. If the emulator is not activated due to other reasons, a message box corresponding to 
the status is displayed.  Use the message as a reference to check the wiring on the 
board. 

3.11 Uninstalling the Emulator’s Software 

Follow this procedure to remove the installed emulator’s software from the user’s host computer.  
As the installed product is registered with the High-performance Embedded Workshop, uninstall 
the product on the High-performance Embedded Workshop screen. 

It is also possible to uninstall the emulator’s software by using [Add/Remove Programs] in the 
control panel.  In this case, however, note that all the tools (including the compiler) in the High-
performance Embedded Workshop will be removed. 

1. Activate the High-performance Embedded Workshop. 

2. Click the [Administration…] button in the [Welcome!] dialog box. 
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Figure 3.37   [Welcome!] Dialog Box 

3. The [Tools Administration] dialog box is opened. 
 

 

Figure 3.38  [Tools Administration] Dialog Box 
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4. Click the [+] mark at the left of [Debugger Components] in the [Registered components] list 
box to list the installed components.  Then, highlight the product name to be uninstalled. 

 

 

Figure 3.39   Highlighting the Product to be Uninstalled 

5. Click the [Unregister] button.  After the following message box is displayed, click the [Yes] 
button. 

 

 

Figure 3.40   [Unregistering this tool] Message Box 

This is the end of canceling the High-performance Embedded Workshop registration.  Then, 
remove the file for the emulator from the host computer. 
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6. Click the [Uninstaller…] button in the [Tools Administration] dialog box to open the 
[Uninstall HEW Tool] dialog box. 

 

 

Figure 3.41   [Uninstall HEW Tool] Dialog Box 
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7. Click the [Start] button to list the installed components. 
 

 

Figure 3.42   Highlighting the Product to be Uninstalled 

Highlight the product name to be uninstalled and click the [Uninstall] button.  This is the end 
of uninstallation. 

CAUTION  
  A shared file may be detected while the program is being 
removed.  If another product may be using the shared file, do 
not remove the file.  If another product does not start up after 
the removal process, re-install that product. 



Section 4   Preparations for Debugging 

  Rev. 1.00  Nov. 26, 2007  Page 55 of 230 

                                                                                       REJ10J1766-0100 

Section 4   Preparations for Debugging 

4.1 Method for Activating High-performance Embedded Workshop 

To activate the High-performance Embedded Workshop, follow the procedure listed below. 

1. Connect the emulator to the host computer and the user system, then turn on the user system. 

2. Select [High-performance Embedded Workshop] from [Renesas] -> [High-performance 
Embedded Workshop] of [Programs] in the [Start] menu. 

3. The [Welcome!] dialog box is displayed. 

 

Figure 4.1   [Welcome!] Dialog Box 

[Create a new project workspace] radio button: Creates a new workspace. 

[Open a recent project workspace] radio button: Uses an existing workspace and displays 
the history of the opened workspace. 

[Browse to another project workspace] radio button: Uses an existing workspace; this radio 
button is used when the history of the 
opened workspace does not remain. 
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The following describes how to activate the High-performance Embedded Workshop when 
selecting [Create a new project workspace] without any toolchain, [Create a new project 
workspace] with a toolchain, and [Browse to another project workspace]. The [Open a recent 
project workspace] radio button is used to omit the operation for specifying the workspace file 
when [Browse to another project workspace] is selected.   

4.1.1 Creating the New Workspace (Toolchain Not Used) 

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded 
Workshop is activated, select [Create a new project workspace] radio button and click the 
[OK] button. 

 

 

Figure 4.2   [Welcome!] Dialog Box 
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2. The Project Generator is started.  In this section, we omit description of the settings for the 
toolchain. 
If you have not purchased the toolchain, the following dialog box is displayed. 

 

 

Figure 4.3   [New Project Workspace] Dialog Box 

[Workspace Name] edit box: Enter the new workspace name.  Here, for example, enter ‘test’. 

[Project Name] edit box: Enter the project name.  When the project name is the same as 
the workspace name, it needs not be entered. 

Other list boxes are used for setting the toolchain; the fixed information is displayed when the 
toolchain has not been installed. 
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3. Make the required setting for the toolchain.  When the setting has been completed, the 
following dialog box is displayed. 

 

 

Figure 4.4   [Setting the Target System for Debugging] Dialog Box 

Check the target emulator and click the [Next] button. 
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4. Set the configuration file name.  The configuration file saves the state of High-performance 
Embedded Workshop except for the emulator. 

 

 

Figure 4.5   [Setting the Debugger Options] Dialog Box 

This is the end of the emulator setting. 

Click the [Finish] button to exit the Project Generator.  The High-performance Embedded 
Workshop is activated. 

5. After the High-performance Embedded Workshop has been activated, the emulator is 
automatically connected.  For operation during connection, refer to section 3.10, System 
Check. 
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4.1.2 Creating the New Workspace (Toolchain Used) 

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded 
Workshop is activated, select [Create a new project workspace] radio button and click the 
[OK] button. 

 

 

Figure 4.6   [Welcome!] Dialog Box 
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2. The Project Generator is started. 
If you have purchased the toolchain, the following dialog box is displayed. 

 

 

Figure 4.7   [New Project Workspace] Dialog Box 

[Workspace Name] edit box: Enter the new workspace name.  Here, for example, enter 
‘test’. 

[Project Name] edit box: Enter the project name.  When the project name is the 
same as the workspace name, it needs not be entered. 

[CPU family] drop-down list box: Select the target CPU family. 

[Tool chain] drop-down list box: Select the target toolchain name when using the toolchain.  
Otherwise, select [None]. 

[Project type] list box: Select the project type to be used. 

Note: When [Demonstration] is selected in the emulator, note the following: 
The [Demonstration] is a program for the simulator.  When the generated program is used 
by the emulator, delete the Printf statement. 
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3. Make the required setting for the toolchain.  When the setting has been completed, the 
following dialog box is displayed. 

 

 

Figure 4.8   [New Project –7/9– Setting the Target System for Debugging] Dialog Box 

Check the target emulator and click the [Next] button.  Mark other products as required. 
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4. Set the configuration file name.  The configuration file saves the state of High-performance 
Embedded Workshop except for the emulator. 

 

 

Figure 4.9   [New Project –8/9– Setting the Debugger Options] Dialog Box 

This is the end of the emulator setting. 

Exit the Project Generator according to the instructions on the screen.  The High-performance 
Embedded Workshop is activated. 

5. After the High-performance Embedded Workshop has been activated, connect the emulator.  
However, it is not needed to connect the emulator immediately after the High-performance 
Embedded Workshop has been activated. 
To connect the emulator, use one of the methods (a) and (b) below.  For operation during 
connection, refer to section 3.10, System Check. 
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(a) Connecting the emulator after the setting at emulator activation 

Select [Debug settings] from the [Debug] menu to open the [Debug Settings] dialog box.  It is 
possible to register the download module or the command chain that is automatically executed 
at activation.  For details on the [Debug Settings] dialog box, refer to section 4.2, Setting at 
Emulator Activation. 

After the [Debug Settings] dialog box has been set, when the dialog box is closed, the emulator 
is connected. 

 
(b) Connecting the emulator without the setting at emulator activation 

The emulator can be easily connected by switching the session file that the setting for the 
emulator use has been registered. 

 

 

Figure 4.10   Selecting the Session File 

In the list box that is circled in figure 4.10, select the session file name including the character 
string that has been set in the [Target name] text box in figure 4.9, [New Project –8/9– Setting the 
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Debugger Options] dialog box.  The setting for using the emulator has been registered in this 
session file. 

After selected, the emulator is automatically connected. 

4.1.3 Selecting an Existing Workspace 

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded 
Workshop is activated, select [Browse to another project workspace] radio button and click the 
[OK] button. 

 

 

Figure 4.11   [Welcome!] Dialog Box 

2. The [Open Workspace] dialog box is displayed. Select a directory in which you have created a 
workspace. 
After that, select the workspace file (.hws) and press the [Open] button. 
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Figure 4.12   [Open Workspace] Dialog Box 

3. This activates the High-performance Embedded Workshop and recovers the state of the 
selected workspace at the time it was saved. 
When the saved state information of the selected workspace includes connection to the 
emulator, the emulator will automatically be connected. To connect the emulator when the 
saved state information does not include connection to the emulator, refer to section 4.4, 
Connecting the Emulator. 
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4.2 Setting at Emulator Activation 

4.2.1 Setting at Emulator Activation 

When the emulator is activated, the command chain can be automatically executed.  It is also 
possible to register multiple load modules to be downloaded.  The registered load modules are 
displayed on the workspace window. 

1. Select [Debug settings] from the [Debug] menu to open the [Debug Settings] dialog box. 
 

 

Figure 4.13   [Debug Settings] Dialog Box ([Target] Page) 

2. Select the product name to be connected in the [Target] drop-down list box. 

3. Select the format of the load module to be downloaded in the [Default Debug Format] drop-
down list box, then register the corresponding download module in the [Download Modules] 
list box. 

Note: Here, no program has been downloaded. For downloading, refer to section 5.2, 
Downloading a Program. 

4. Click the [Options] tab. 
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Figure 4.14   [Debug Settings] Dialog Box ([Options] Page) 

The command chain that is automatically executed at the specified timing is registered.  The 
following four timings can be specified: 

• At connecting the emulator 

• Immediately after reset 

• Immediately before downloading 

• Immediately after downloading 
 
Specify the timing for executing the command chain in the [Command batch file load timing] 
drop-down list box.  In addition, register the command-chain file that is executed at the specified 
timing in the [Command Line Batch Processing] list box. 
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4.2.2 Downloading a Program 

A download module is added under [Download modules] in the [Workspace] window. 

Open the load module of [Download modules] in the [Workspace] window by clicking the right-
hand mouse button and select [Download module] to start downloading the module. 

 

Figure 4.15   Download Menu of the [Workspace] Window ([Projects]) 

Notes: 1. When load modules are downloaded, select [Debug] -> [Download] -> [All DownLoad 
Modules]. 

 2. To proceed with source-level debugging with the High-performance Embedded 
Workshop for CPU0 or the High performance Embedded Workshop for CPU1, 
download the debugging information file for the corresponding CPU. 
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4.3 Debug Sessions 

The High-performance Embedded Workshop stores all of your builder options into a 
configuration.  In a similar way, the High-performance Embedded Workshop stores your debugger 
options in a session.  The debugging platforms, the programs to be downloaded, and each 
debugging platform’s options can be stored in a session. 

Sessions are not directly related to a configuration.  This means that multiple sessions can share 
the same download module and avoid unnecessary program rebuilds. 

Each session’s data should be stored in a separate file in the High-performance Embedded 
Workshop project.  Debug sessions are described in detail below. 

4.3.1 Selecting a Session 

The current session can be selected in the following two ways: 

• From the toolbar 

Select a session from the drop-down list box (figure 4.16) in the toolbar. 
 

 

Figure 4.16   Toolbar Selection 
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• From the dialog box 

1. Select [Debug -> Debug Sessions…]. This will open the [Debug Sessions] dialog box 
(figure 4.17). 

 

 

Figure 4.17   [Debug Sessions] Dialog Box 

2. Select the session you want to use from the [Current session] drop-down list. 

3. Click the [OK] button to set the session. 
 

4.3.2 Adding and Removing Sessions 

A new session can be added by copying settings from another session or removing a session. 

• To add a new empty session 

1. Select [Debug -> Debug Sessions…] to display the [Debug Sessions] dialog box (figure 
4.17). 

2. Click the [Add…] button to display the [Add new session] dialog box (figure 4.18). 

3. Check the [Add new session] radio button. 

4. Enter a name for the session. 
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5. Click the [OK] button to close the [Debug Sessions] dialog box. 

6. This creates a file with the name entered in step 4.  If a file with this name already exists, 
an error is displayed. 

 

 

Figure 4.18   [Add new session] Dialog Box 

• To import an existing session into a new session file 

1. Select [Debug -> Debug Sessions…] to display the [Debug Sessions] dialog box (figure 
4.17). 

2. Click the [Add…] button to display the [Add new session] dialog box (figure 4.18). 

3. Check the [Use an existing session file] radio button. 

4. Enter a name for the session. 

5. Enter the name of an existing session file that you would like to import into the existing 
project or click the [Browse] button to select the file location. 

If the [Open and maintain link to session file] check box is not checked, the imported new 
session file is generated in the project directory. 

If the [Open and maintain link to session file] check box is checked, a new session file is 
not generated in the project directory but is linked to the existing session file. 

If the [Make session file link read only] check box is checked, the linked session file is 
used as read-only. 

6. Click the [OK] button to close the [Debug Sessions] dialog box. 
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• To remove a session 

1. Select [Debug -> Debug Sessions…] to display the [Debug Sessions] dialog box (figure 
4.17). 

2. Select the session you would like to remove. 

3. Click the [Remove] button. 

Note that the current session cannot be removed. 

4. Click the [OK] button to close the [Debug Sessions] dialog box. 
 
• To view the session properties 

1. Select [Debug -> Debug Sessions…] to display the [Debug Sessions] dialog box (figure 
4.17). 

2. Select the session you would like to view the properties for. 

3. Click the [Properties] button to display the [Session Properties] dialog box (figure 4.19). 
 

 

Figure 4.19   [Session Properties] Dialog Box 

• To make a session read-only 

1. Select [Debug -> Debug Sessions…] to display the [Debug Sessions] dialog box (figure 
4.17). 

2. Select the session you would like to make read-only. 

3. Click the [Properties] button to display the [Session Properties] dialog box (figure 4.19). 

4. Check the [Read only] check box to make the link read-only.  This is useful if you are 
sharing debugger-setting files and you do not want data to be modified accidentally. 

5. Click the [OK] button. 
 
• To save a session with a different name 

1. Select [Debug -> Debug Sessions…] to display the [Debug Sessions] dialog box (figure 
4.17). 

2. Select the session you would like to save. 

3. Click the [Save as…] button to display the [Save Session] dialog box (figure 4.20). 
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4. Specify the location to save the new file. 

5. If you want to export the session file to another location, leave the [Maintain link] check 
box unchecked.  If you would like the High-performance Embedded Workshop to use this 
location instead of the current session location, check the [Maintain link] check box. 

6. Click the [Save] button. 
 

 

Figure 4.20   [Save Session] Dialog Box 

4.3.3 Saving Session Information 

• To save a session 

Select [File -> Save Session]. 
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4.4 Connecting the Emulator 

Select either of the following two ways to connect the emulator: 

(a) Connecting the emulator after the setting at emulator activation 

Select [Debug settings] from the [Debug] menu to open the [Debug Settings] dialog box.  It is 
possible to register the download module or the command chain that is automatically executed 
at activation.  For details on the [Debug Settings] dialog box, refer to section 4.2, Setting at 
Emulator Activation. 

After the [Debug Settings] dialog box has been set, when the dialog box is closed, the emulator 
is connected. 

 
(b) Connecting the emulator without the setting at emulator activation 

The emulator can be easily connected by switching the session file that the setting for the 
emulator use has been registered. 

 

 

Figure 4.21   Selecting the Session File 
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In the list box that is circled in figure 4.21, select the session file name including the character 
string that has been set in the [Target name] text box in figure 4.9, [New Project –8/9– Setting the 
Debugger Options] dialog box.  The setting for using the emulator has been registered in this 
session file. 

After the session file name is selected, the emulator will automatically be connected. For details 
on the session file, refer to section 4.3, Debug Sessions. 

4.5 Reconnecting the Emulator 

When the emulator is disconnected, use the following way for reconnection: 

Select [Debug -> Connect] or click the [Connect] toolbar button ( ). The emulator is connected. 

Note: The emulator must be selected in the [Target] drop-down list box of the [Debug Settings] 
dialog box (see figure 4.13, [Debug Settings] Dialog Box ([Target] Page)) that is opened 
by selecting [Debug settings] from the [Debug] menu. 
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4.6 Ending the Emulator 

When using the toolchain, the emulator can be exited by using the following two methods: 

• Canceling the connection of the emulator being activated 

• Exiting the High-performance Embedded Workshop 

(1) Canceling the connection of the emulator being activated 

Select [Disconnect] from the [Debug] menu or click the [Disconnect] toolbar button ( ). 
 
(2) Exiting the High-performance Embedded Workshop 

Select [Exit] from the [File] menu. 

A message box is displayed.  If necessary, click the [Yes] button to save a session.  After 
saving a session, the High-performance Embedded Workshop exits.  If not necessary, click the 
[No] button to exit the High-performance Embedded Workshop. 

 

 

Figure 4.22   [Session has been modified] Message Box 
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Section 5   Debugging 

This section describes the debugging operations and their related windows and dialog boxes. 

5.1 Setting the Environment for Emulation 

5.1.1 Opening the [Configuration] Dialog Box 

Selecting [Setup -> Emulator -> System…] or clicking the [Emulator System] toolbar button ( ) 
opens the [Configuration] dialog box. 

5.1.2 [General] Page 

Sets the emulator operation conditions. These settings will apply to the High-performance 
Embedded Workshops for both CPU0 and CPU1. 
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Figure 5.1   [Configuration] Dialog Box ([General] Page) 

Items that can be displayed in the sheet are listed below. 
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[Mode] Displays the MPU name. 
  
[Emulation mode] Selects the emulation mode at user program execution. 

Select Normal to perform normal emulation. 

Select No break to disable PC breakpoint or break condition 
settings during emulation. 

  
[Step option] Sets the step interrupt option. 

Disable interrupts during single step execution: Disables 
interrupts*1 during step execution. 

Enable interrupts during single step execution: Enables 
interrupts during step execution. 

  
[Read/Write on the fly] Sets the mode of memory access during execution of the user 

program (this does not affect access to memory by the user 
program). 

Disable: Memory access is not possible during execution of the 
user program. 

H-UDI Read/Write: Execute the memory access by using the 
H_UDI. 

Short Break Read/Write: Access to memory is during short 
breaks in execution of the user program. This suspends 
execution of the user program for longer periods than access 
via the H-UDI. 

  
[AUD clock] A clock used in acquiring AUD traces. If its frequency is set 

too low, complete data may not be acquired during realtime 
tracing. Set the frequency not to exceed the upper limit for the 
MPU's AUD clock. The AUD clock is only needed for using 
emulators that have an AUD trace function. For the upper limit 
for the AUD clock, refer to section 2.2.3, Notes on Using the 
JTAG (H-UDI) Clock (TCK) and AUD Clock (AUDCK), in 
the additional document, Supplementary Information on Using 
the SHxxxx. 

  
[JTAG clock] A communication clock used except for acquiring AUD trace. 

If its frequency is set too low, the speed of downloading will 
be lowered. Set the frequency not to exceed the upper limit for 
the MPU's guaranteed TCK range. For the upper limit for 
TCK, refer to section 2.2.3, Notes on Using the JTAG (H-UDI) 
Clock (TCK) and AUD Clock (AUDCK), in the additional 
document, Supplementary Information on Using the SHxxxx. 
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[Flash memory synchronization]  Selects whether or not the contents of the flash memory are 
acquired by the emulator when the user program is stopped or 
the position where the PC break is set is put back as the 
original code. 

When the flash memory is not reprogrammed by the user 
program, its contents need not be acquired by the emulator. 

If there is no problem with the state that the program in the 
flash memory has been replaced as the PC break code, the 
position where the PC break is set needs not be put back as the 
original code. 

Disable:  Read or program is not performed on the flash 
memory except when the emulator is activated, the 
flash memory area is modified, and the settings of 
the PC break to the flash memory area are changed. 

PC to flash memory:  When the user program is stopped, the 
specified PC break code is replaced as 
the original instruction. Select this 
option if there is a problem with the state 
that the program in the flash memory 
has been replaced as the PC break code. 

Flash memory to PC: When the user program is stopped, the 
contents of the flash memory are read by 
the emulator. Select this option if the 
flash memory is reprogrammed by the 
user program. 

PC to flash memory, Flash memory to PC:  
When the user program is stopped, the 
contents of the flash memory are read by 
the emulator and the specified PC break 
code is replaced as the original 
instruction. Select this option if the flash 
memory is reprogrammed by the user 
program and there is a problem with the 
state that the program in the flash 
memory has been replaced as the PC 
break code. 

Control the behavior of the MCU in terms of transition to deep 
standby or software standby.*2    

Standby:                     Specifies transitions to deep standby or 
software standby mode 

[Standby Mode] 
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 Sleep:                       Specifies transitions to sleep mode.*2 

[Synchronization options]          Specify the operation of synchronized execution. 

                                                    Go:  Execution is synchronized. *3 When 
this condition is modified, all of the 
PC break points will be erased. 

                                                    Step:  Stepping is synchronized.*4  When this 
condition is modified, all of the PC 
break points will be erased. 

                                                    Break:  Breaks are synchronized.*5  When this 
condition is modified, all of the PC 
break points or event points will be 
erased. 

Notes:  

1.    Includes the interrupts during a break. 

2. When one of the CPU transfers to the deep standby mode and the [Software standby 
mode] during execution of the user program, the emulator can not access the memory 
and can not perform a break.  To keep performing the emulator, after releasing the 
[Deep standby mode] and the [Software standby mode], operate the emulator or 
replace the deep standby mode and the software standby mode to sleep mode by 
selecting the [Sleep mode] in this emulator.  

3. To perform the synchronized execution, after the setting of [Go] options, clicking on 
the [Execution] button or the command line in each of High-performance Embedded 
Workshop for CPU0 and CPU1 is needed. When both of the High-performance 
Embedded Workshop became the executed mode, the synchronized execution for the 
actual user program will be started. 

4. When setting the synchronized stepping, the synchronized execution and the 
synchronized break will be set on a mandatory. To perform the synchronized stepping, 
after setting the [Step] options from the [Synchronization options], in either CPU0 or 
CPU1 of the High-performance Embedded Workshop, at first, click on the [Step In] 
([Step Over] or [Step Out]) button or the command line in the each of High-
performance Embedded Workshop for CPU0 or CPU1. Next, to execute the user 
program by clicking on the [Execute] or the [Step In] button are needed. When the 
both of the High-performance Embedded Workshop became the execution mode, the 
synchronized [Step In] ([Step Over] or [Step Out]) for the actual user program will be 
started.  
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5. When the break is occurred in either of CPU0 or CPU1, the other emulator will also 
break. 

 

Note: The items that can be set in this dialog box vary according to the emulator in use. For 
details, refer to the online help. 

5.1.3 Downloading to the Flash Memory 

Sets the emulator operation conditions for downloading the external flash memory. This function 
is not available depending on the MCU. 

For details, refer to section 6.22, Download Function to the Flash Memory Area. These settings 
are not common to the High-performance Embedded Workshops for CPU0 and CPU1. That is, 
each High-performance Embedded Workshop has its own settings. 
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Figure 5.2   [Configuration] Dialog Box ([Loading flash memory] Page) 
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Items that can be displayed in the sheet are listed below. 

[Loading flash memory] Sets Enable for flash memory downloading. At Enable, when 
the flash memory is downloaded on the High-performance 
Embedded Workshop, the write module is always called. 

Disable: Not download to the flash memory 

Enable: Download to the flash memory 
  
[Erasing flash memory] Sets Enable for erasing before the flash memory is 

programmed. At Enable, the erase module is called before 
calling the write module. 

Disable: Not erase the flash memory 

Enable: Erase the flash memory 
  
[File name] Sets the write/erase module name. The file that has been set is 

loaded to the RAM area before loading to the flash memory. 
  
[Bus width of flash memory] Sets the bus width of the flash memory. 
  
[Flash memory erasing time] Sets the TIMEOUT value at flash memory erasing. Increase 

the value if erasing requires much time although the default 
time is three minutes. The values that can be set are as follows: 
D'0 (minimum) and D’65535 (maximum). Only positive 
integers can be input. 

  
[Entry point] Sets the calling destination address or access size of the 

write/erase module. (It must be RAM address.) 

All erasing module address: Inputs the calling destination 
address of the erase module. 

Writing module address:      Inputs the calling destination 
address of the write module. 

Access size:                          Selects the access size of the RAM 
area that is used for loading the 
write/erase module. 
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5.2 Downloading a Program 

This section describes how to download a program and view it as source code or assembly-
language mnemonics. 

Note: After a break has been detected, the High-performance Embedded Workshop displays the 
location of the program counter (PC). In most cases, for example if an Elf/Dwarf2-based 
project is moved from its original path, the source file may not be automatically found.  In 
this case, the High-performance Embedded Workshop will open a source file browser 
dialog box to allow you to manually locate the file. 

5.2.1 Downloading a Program 

A load module to be debugged must be downloaded. 

To download a program, select the load module from [Debug -> Download] or select [Download] 
from the popup menu opened by clicking the right-hand mouse button on the load module in 
[Download modules] of the [Workspace] window. 

Notes: 1. Before downloading a program, it must be registered to the High-performance 
Embedded Workshop as a load module. For registration, refer to section 4.2, Setting at 
Emulator Activation. 

2. When a program is downloaded to the external RAM, the bus controller must be 
initially set in the area for downloading. Especially, check that the initialization of 
SDRAM or the setting of the bus width is appropriate for the target system. Download 
the corresponding debugging information file to execute source-level debugging on 
the High-performance Embedded Workshop for CPU0 or CPU1. 

  3.  To proceed with source-level debugging with the High-performance Embedded   
Workshop for CPU0 or the High-performance Embedded Workshop for CPU1, 
download the debugging information file for the corresponding CPU. 

 

5.2.2 Viewing the Source Code 

Select your source file and click the [Open] button to make the High-performance Embedded 
Workshop open the file in the integrated editor.  It is also possible to display your source files by 
double-clicking on them in the [Workspace] window. 
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Figure 5.3   [Source] Window 

In this window, the following items are shown on the left as line information. 

 The first column (Source address column): Address information 

 The second column (Event column): Event information (break condition) 

 The third column (S/W breakpoint column): PC, bookmark, and breakpoint information 

Source address column 

When a program is downloaded, an address for the current source file is displayed on the Source 
address column. These addresses are helpful when setting the PC value or breakpoints. 

Event column 

The Event column displays the following item: 

:An address condition for the break condition is set. The number of address conditions that can 
be set is the same as that of break condition channels at which the address condition can be set, 
but it differs depending on the product. 

This is also set by using the popup menu.  

The bitmap symbol above is shown by double-clicking the Event column. This is also set by using 
the popup menu.  



Section 5   Debugging 

  Rev. 1.00  Nov. 26, 2007  Page 89 of 230 

                                                                                       REJ10J1766-0100 

 

Figure 5.4   Popup Menu 

Note: The contents of the Event column are erased when conditions other than the address 
condition are added to each channel by using the [Edit] menu or in the [Event] window. 

 
S/W breakpoint column 

S/W breakpoint column displays the following items: 

: A bookmark is set. 

: A PC Break is set. 

: PC location 

 
 To switch off a column in all source files 

1. Click the right-hand mouse button on the [Source] window or select the [Edit] menu.  

2. Click the [Define Column Format…] menu item. 

3. The [Global Editor Column States] dialog box is displayed. 

4. A check box indicates whether the column is enabled or not.  If it is checked, the column is 
enabled. If the check box is gray, the column is enabled in some files and disabled in 
others.  Deselect the check box of a column you want to switch off. 

5. Click the [OK] button for the new column settings to take effect. 
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Figure 5.5   [Global Editor Column States] Dialog Box 

 To switch off a column in one source file 

1. Open the source file which contains the column you want to remove and click the [Edit] 
menu. 

2. Click the [Columns] menu item to display a cascaded menu item.  The columns are 
displayed in this popup menu.  If a column is enabled, it has a tick mark next to its name.  
Clicking the entry will toggle whether the column is displayed or not. 

 

5.2.3 Viewing the Assembly-Language Code 

Click the [Disassembly] toolbar button at the top of the window when a source file is opened to 
show the assembly-language code that corresponds to the current source file. 

If you do not have a source file, but want to view code in the assembly-language level, either 
choose [View] -> [Disassembly…] or click the [Disassembly] toolbar button ( ). The 
[Disassembly] window opens at the current PC location and shows [Address] and [Code] 
(optional) which show the disassembled mnemonics (with labels when available).  

Selecting the [Mixed display] toolbar button ( ) displays both the source and the code. The 
following shows an example in this case. 
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Figure 5.6   [Disassembly] Window 

5.2.4 Modifying the Assembly-Language Code 

You can modify the assembly-language code by double-clicking on the instruction that you want 
to change. The [Assembler] dialog box will be opened. 

 

Figure 5.7   [Assembler] Dialog Box 

The address, machine code, and disassembled instruction are displayed. Enter the new instruction 
or edit the current instruction in the [Mnemonic] field. Pressing the [Enter] key will assemble the 
instruction into memory and move on to the next instruction. Clicking the [OK] button will 
assemble the instruction into memory and close the dialog box. Clicking the [Cancel] button or 
pressing the [Esc] key will close the dialog box. 

Note: The assembly-language display is disassembled from the machine code on the actual 
memory. If the memory contents are changed, the dialog box (and the [Disassembly] 
window) will show the new assembly-language code, but the display content of the 
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[Editor] window will not be changed. This is the same even if the source file contains 
assembly codes. 

5.2.5 Viewing a Specific Address 

When you are viewing your program in the [Disassembly] window, you may want to look at 
another area of your program's code. Rather than scrolling through a lot of code in the program, 
you can go directly to a specific address. Double-click on the address in the [Disassembly] 
window or select [Set Address…] from the popup menu, and the dialog box shown in figure 5.8 is 
displayed. 

 

Figure 5.8   [Set Address] Dialog Box 

Enter the address or label name in the edit box and either click on the [OK] button or press the 
[Enter] key. The [Disassembly] window will be updated to show the code at the new address. 
When an overloaded function or a class name is entered, the [Select Function] dialog box opens 
for you to select a function. 

5.2.6 Viewing the Current Program Counter Address 

Wherever you can enter an address or value into the High-performance Embedded Workshop, you 
can also enter an expression.  If you enter a register name prefixed by the hash character, the 
contents of that register will be used as the value in the expression. Therefore, if you open the [Set 
Address] dialog box and enter the expression #pc, the [Editor] or [Disassembly] window will 
display the current PC address. It also allows the offset of the current PC to be displayed by 
entering an expression with the PC register plus an offset, e.g., #PC+0x100. 
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5.3 Displaying Memory Contents in Realtime 

Use the [Monitor] window to monitor the memory contents during user program execution. These 
settings will not be common to the High-performance Embedded Workshops for CPU0 and CPU1. 
That is, each High-performance Embedded Workshop has its own settings. 

Note: This function is not supported in some devices to be debugged. For details on the 
specifications of each product, refer to the online help. 

5.3.1 Opening the [Monitor] Window 

To open the [Monitor] window, select [View -> CPU -> Monitor -> Monitor Setting...] or click the 
[Monitor] toolbar button ( ) to display the [Monitor Setting] dialog box. 
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Figure 5.9   [Monitor Setting] Dialog Box 

[Name]:  Decides the name of the monitor window. 

[Options]: Sets monitor conditions. 

[Address]:   Sets the start address for monitoring. 

[Size]:   Sets the range for monitoring. 

[Access]:   Sets the access size to be displayed in the monitor window. 
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[Auto-Refresh at rate]:  Sets the interval for acquisition by monitoring. 

[Reading the Initial Value]: Selects reading of the values in the monitored area when the 
monitor window is opened. 

 [Color]:  Sets the method to update monitoring and the attribute of colors. 

[Change Indicator]: Selects how to display the values that have changed during 
monitoring (available when [Reading the Initial Value] has 
been selected). 

    No change: No color change. 

Change: Color is changed according to the [Foreground] and 
[Background] options. 

Gray: Those data with values that have not been changed are 
displayed in gray. 

Appear: A value is only displayed after changed. 

[Foreground]: Sets the color used for display (available when [Change] has 
been selected). 

[Background]: Sets the background color (available when [Change] has been 
selected). 

[Mayfly]: A check in this box selects restoration of the color of those 
data which have not been updated in a specified interval to the 
color selected in the [Background] option. The specified 
interval is the interval for monitor acquisition (available when 
[Change], [Gray], or [Appear] has been selected). 

[Detail]:  Not supported in the emulator. 

[History]: Displays the previous settings. 

Note: Selection of the foreground or background color may not be available depending on the 
operating system in use. 

After setting, clicking the [OK] button displays the [Monitor] window. 
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Figure 5.10   [Monitor] Window 

During user program execution, the display is updated according to the setting value of the auto-
update interval. 

Note: Select [Refresh] from the popup menu when data is not displayed correctly after changing 
the address or content of memory. 

5.3.2 Changing the Monitor Settings 

Selecting [Monitor Settings...] from the popup menu of the [Monitor] window displays the 
[Monitor Setting] dialog box, which allows the settings to be changed. 

Colors, the size of accesses, and the display format can be easily changed from [Color] or [Access] 
of the popup menu. 

5.3.3 Temporarily Stopping Update of the Monitor 

During user program execution, the display of the [Monitor] window is automatically updated 
according to the auto-update interval. Select [Lock Refresh] from the popup menu of the 
[Monitor] window to stop the update of display. The characters in the address section are 
displayed in black, and the update of display is stopped. 

Selecting [Lock Refresh] again from the popup menu cancels the stopped state. 

5.3.4 Deleting the Monitor Settings 

Selecting [Close] from the popup menu of the [Monitor] window to be deleted closes the 
[Monitor] window and deletes the monitor settings. 
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5.3.5 Monitoring Variables 

Using the [Watch] window refers to the value of any variables. 

When the address of the variable registered in the [Watch] window exists within the monitoring 
range that has been set by the Monitor function, the value of the variable can be updated and 
displayed. 

This function allows checking the content of a variable without affecting the realtime operation. 

5.3.6 Hiding the [Monitor] Window 

When using the Monitor function to monitor the value of a variable from the [Watch] window, 
hide the [Monitor] window for the effective use of the screen. 

The current monitoring information is listed as the submenu when selecting [Display -> CPU -> 
Monitor]. The list consists of the [Monitor] window name and the address to start monitoring. 

When the left of the list is checked, the [Monitor] window is being displayed. 

Selecting items of the [Monitor] window you want to hide from the monitor setting list displays no 
[Monitor] window and removes the check mark at the left of the list. 

To display the [Monitor] window again, select the hidden the [Monitor] window. 

 

Figure 5.11   Monitor Setting List 
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5.3.7 Managing the [Monitor] Window 

Selecting [Display -> CPU -> Monitor -> Windows Select…] displays the [Windows Select] 
dialog box. In this window, the current monitoring condition is checked and the new monitoring 
condition is added, edited, and deleted in succession.  

Selecting multiple monitoring conditions enables a temporary stop of update, hiding, and deletion. 

 

Figure 5.12   [Windows Select] Dialog Box 
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5.4 Viewing the Current Status 

Choose [View -> CPU -> Status] or click the [View Status] toolbar button ( ) to open the 
[Status] window and see the current status of the debugging platform. 

 

Figure 5.13   [Status] Window 

The [Status] window has three sheets: 

• [Memory] sheet 

Contains information about the current memory status including the memory-mapping 
resources and the areas used by the currently loaded object file. 

• [Platform] sheet 

Contains information about the status of the emulator, typically including the CPU type and 
emulation mode, the state of execution, and the statistic information of execution. 

• [Events] sheet 

Contains information about the event information, including resource information and 
breakpoints. 

 
Note: The items that can be set in this dialog box vary according to the emulator in use. For 

details, refer to the online help. 
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5.5 Using the Event Points 

The emulator has the event point function that performs breaking, tracing, and execution time 
measurement by specifying more complex conditions along with the PC breakpoints standard for 
the High-performance Embedded Workshop. 

5.5.1 PC Breakpoints 

When the instruction of the specified address is fetched, the user program is stopped. Up to 255 
points can be set.                                                                                                                            
These settings will not be common to the High-performance Embedded Workshops for CPU0 and 
CPU1. That is, each High-performance Embedded Workshop has its own settings. 

 

5.5.2 Event Conditions 

Event conditions can be used for more complex conditions such as the data condition as well as 
specification of the single address.  

When the condition is satisfied, break conditions are also used as the start/end conditions for 
performance measurement in addition to halting the user program.  When event conditions are 
used as the start/end conditions for performance measurement, start from setting in the 
[Performance Analysis] window. 

Several event conditions can be combined in a more complex condition. These settings are 
common to the High-performance Embedded Workshops for CPU0 and CPU1. 

Notes: 1. When break conditions are used as the start/end conditions for performance 
measurement, step operation cannot be performed. In addition, when execution is 
restarted from the address where step operation has been stopped by the 
BREAKPOINT, the single step function is used and operation is disabled. Restart 
execution after the BREAKPOINT has been canceled. 

 2. It is not possible to use the break conditions and the start/end conditions for 
performance measurement at the same time with one channel. If the performance 
measurement start/end conditions are set, the settings of the break conditions will be 
disabled. 

 3. The break conditions that can be set vary according to the emulator in use. For details, 
refer to the online help. 
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5.5.3 Opening the [Event] Window 

Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button ( ) to open the 
[Event] window. 

The [Event] window has the following two sheets: 

[Breakpoint] sheet: Displays the settings made for PC breakpoints. It is also possible to set, 
modify, and cancel PC breakpoints. 

[Event condition] sheet:  Displays or sets the settings made for break condition channels.  

 

5.5.4 Setting PC Breakpoints 

It is possible to display, modify, and add PC breakpoints on the [Breakpoint] sheet. 

 

Figure 5.14   [Event] Window ([Breakpoint] Sheet) 

This window displays and sets the breakpoints. Items that can be displayed in the sheet are listed 
below. 

[Type] Breakpoint 

[State] Whether the breakpoint is enabled or disabled 

[Condition] An address that the breakpoint is set 
 Address = Program counter (Corresponding file name, line, and symbol name) 
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[Action] Operation of the emulator when a break condition is satisfied 
 Break: Breaks program execution 

Notes:  

1. PC breakpoints can only be set when all of synchronized execution, synchronized stepping, 
and synchronized breaks have been selected. 

2. Do not set PC breakpoints at the same address in the High-performance Embedded 
Workshops for CPU0 and CPU1. 

3. The details of settings differ from product to product. Refer to the online help system for 
details on the settings for particular products.  

When a breakpoint is double-clicked in this window, the [Breakpoint] dialog box is opened and 
break conditions can be modified. 

A popup menu containing the following options is available by right-clicking within the window. 

5.5.5 Add 

Sets breakpoints. Clicking this item will open the [Breakpoint] dialog box and break conditions 
can be specified. 

5.5.6 Edit 

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item. 
The [Breakpoint] dialog box will open and break conditions can be changed.  

5.5.7 Enable 

Enables the selected breakpoint(s). 

5.5.8 Disable 

Disables the selected breakpoint(s). When a breakpoint is disabled, the breakpoint will remain in 
the list; when specified conditions have been satisfied, a break will not occur. 

5.5.9 Delete 

Removes the selected breakpoint. To retain the details of the breakpoint but not have it cause a 
break when its conditions are met, use the Disable option (see section 5.5.8, Disable). 
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5.5.10 Delete All 

Removes all breakpoints. 

5.5.11 Go to Source 

Only enabled when one breakpoint is selected. Opens the [Source] window at the address of the 
breakpoint. 

5.5.12 [Breakpoint] Dialog Box 

 

Figure 5.15   [Breakpoint] Dialog Box 

This dialog box specifies break conditions.  

A breakpoint address to be set is specified in the [Value] edit box. The PC register can also be 
specified such as #PC. Up to 255 breakpoints can be specified. 

The contents to be set differ depending on the product. For details, refer to the on-line help for 
each product. 
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When [Value] is selected, if an overloaded function or class name including a member function is 
specified in address, the [Select Function] dialog box opens. 

Clicking the [OK] button sets the break conditions. Clicking the [Cancel] button closes this dialog 
box without setting the break conditions. 

5.5.13 Setting Break Conditions 

On the [Event condition] sheet, the settings for break conditions are displayed, modified, and 
added. 

 

Figure 5.16   [Event] Window ([Event condition] Sheet) 

This window displays and sets the break condition. Since the number of channels for detecting 
conditions and the contents to be set differ depending on the product, refer to the on-line help for 
each product. 

Items that can be displayed in the sheet are listed below. 

[Type] Break channel number 

[State] Whether the breakpoint is enabled or disabled 
 Enable: Valid 
 Disable: Invalid 

[Condition] A condition that satisfies a break. The displayed contents differ depending on the 
break type. 

[Action] Operation of the emulator when a break condition is satisfied. 
 Break: Breaks program execution 
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When a breakpoint is double-clicked in this window, the [Event condition] dialog box is opened 
and break conditions can be modified. For details on the [Event condition] dialog box, refer to the 
on-line help for each product. 

A popup menu containing the following options is available by right-clicking within the window. 

5.5.14 Edit... 

Only enabled when one break channel is selected. Select a breakpoint to be edited and click this 
item. The [Event condition] dialog box will open and break conditions can be changed.  

5.5.15 Enable 

Enables the selected break channel(s). A break channel that the condition has not been set is not 
enabled. 

5.5.16 Disable 

Disables the selected break channel(s). When a break channel is disabled, a break will not occur 
even if specified conditions have been satisfied. 

5.5.17 Delete 

Initializes the condition of the selected break channel. To retain the details of the break channel 
but not have it cause a break when its conditions are met, use the Disable option (see section 
5.5.16, Disable). 

5.5.18 Delete All 

Initializes conditions of all break channels. 

5.5.19 Go to Source 

Only enabled when one break channel is selected. Opens the [Source] window at address of break 
channel. 

If an address value has not been set to the break channel, this option cannot be used. 
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5.5.20 Sequential Conditions 

Sets the sequential condition of the break channel. 

5.5.21 Editing Break Conditions 

Handlings for settings other than PC breakpoints and break conditions are common. The following 
describes examples of such handling. 

5.5.22 Modifying Break Conditions 

Select a break condition to be modified, and choose [Edit...] from the popup menu to open the 
dialog box for the event, which allows the user to modify the break conditions. The [Edit...] menu 
is only available when one break condition is selected.  

5.5.23 Enabling Break Conditions 

Select a break condition and choose [Enable] from the popup menu to enable the selected break 
condition. 

5.5.24 Disabling Break Conditions 

Select a break condition and choose [Disable] from the popup menu to disable the selected break 
condition. When a break condition is disabled, the break condition will remain in the list, but an 
event will not occur when the specified conditions have been satisfied. 

5.5.25 Deleting Break Conditions 

Select a break condition and choose [Delete] from the popup menu to remove the selected break 
condition. To retain the break condition but not have it cause an event when its conditions are met, 
use the [Disable] option (see section 5.5.24, Disabling Break Conditions). 

5.5.26 Deleting All Break Conditions 

Choose [Delete All] from the popup menu to remove all break conditions. 
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5.5.27 Viewing the Source Line for Break Conditions 

Select a break condition and choose [Go to Source] from the popup menu to open the [Source] or 
[Disassembly] window at the address of the break condition. The [Go to Source] menu is only 
available when one break condition that has the corresponding source file is selected.  

5.6 Viewing the Trace Information 

For the description on the trace function, refer to section 2.2, Trace Functions. 

5.6.1 Opening the [Trace] Window 

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button 
( ). 

5.6.2 Acquiring Trace Information 

The pop up menu of the [Trace window] has a [Settings…] item. If the [Settings…] item is 
selected, the [Acquisition] dialog box will be displayed.  If [I-Trace] is selected as the [Trace 
Type] in this dialog box, the trace information will be acquired by using the internal trace 
function. 

The acquired trace information is displayed in the [Trace] window. 

 

Figure 5.17   [Trace] Window (I-Trace) 

This window displays the following trace information items: 

[PTR] Pointer to a location in the trace buffer (+0 for the last executed instruction) 
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[IP] The amount of acquired trace information 

[CPU ID] Type of the CPU core: 
 CPU0: Trace is made for CPU0                                                                          
 CPU1: Trace is made for CPU1 

[Master] Master device that generated the event. 
 CPU: CPU0 was the master.                                                                         
 DMA: The DMAC was the master. 

[Type] Type of the trace information  
 BRANCH: Branch source  
 DESTINATION: Branch destination 
 MEMORY: Memory access  
 PC-RELATIVE: PC-relative access 
 INSTRUCTION: Instruction fetching from the external space 
 S_TRACE: Indicates execution of the Trace (x) function 
 OPERAND PRE-FETCH: Execution of the PREF instruction. 

[Branch Type] Type of the branch: 
 GENERAL: General branch 
 SUBROUTINE: Subroutine branch 
 EXCEPTION: Exception branch 

[Bus] Display the access type of the cycle: 
 F-Bus: F bus 
 M-Bus: M bus 
 I-Bus: I bus 
 DMA: Direct memory access 

 

[R/W] Display whether access to data is reading or writing 
 READ: Read access 
 WRITE: Write access 

 

[Address] Instruction address 

[Data] Display the data value 
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[Size] Display the size of access: 
 BYTE: Byte 
 WORD: Word 
 LONG: Longword 

[Instruction] Instruction mnemonic 

[Time stamp] Time stamp, in cycles of Bφ 

[Source] The C/C++ or assembly-language source program 

[Label] Label information 

Selecting the [Set…] menu in the popup menu of the [Trace] window displays the [Acquisition] 
dialog box. When [AUD function] is selected in [Trace Type] within the dialog box, the trace 
information is acquired by using the AUD trace function. 

 

Figure 5.18   [Trace] Window (AUD Trace) 

This window displays the following trace information items (some of this information will not be 
displayed in some products): 

[PTR] Pointer to a location in the trace buffer (+0 for the last executed instruction) 

[IP] The amount of items of acquired trace information 

[CPU_ID] Type of the CPU core 
 CPU0: Trace is for CPU0                                                                          
 CPU1: Trace is for CPU1 
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[Master] Master device that generated the event: 
 CPU: CPU0 was the master 

[Type] Type of the trace information: 
 BRANCH: Branch source 
 DESTINATION: Branch destination 
 MEMORY: Memory access 
 S_TRACE: Executed Trace(x) function 
 LOST: Lost trace information (only in the realtime mode) 
 CPU-WAIT: CPU was waiting for the output of the trace information  
        (only in the non-realtime mode) 

[Branch Type] Type of the branch: 
 GENERAL: General branch 
 SUBROUTINE: Subroutine branch 
 EXCEPTION: Exception branch  

[Bus] Display the access type of the cycle: 
 M-Bus: M bus 
 I-Bus: I bus 

[R/W] Display whether access to data is reading or writing 
 READ: Read access 
 WRITE: Write access 

[Address] Instruction address (AUD trace: If there is no base address in the trace buffer, 
display the difference only) 

[Data] Display the data value. 

[Size] Display the size of access: 
 BYTE: Byte 
 WORD: Word 
 LONG: Longword 

[Instruction] Instruction mnemonic 

[Timestamp] No timestamp, value is fixed to 0 

[Source] The C/C++ or assembly-language source program 

[Label] Label information 
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Note: Since the displayed contents differ depending on the product, refer to each product’s 
online help. Some MPUs supported may not have the AUD trace function. 

It is possible to hide any column not necessary in the [Trace] window. Selecting a column you 
want to hide from the popup menu displayed by clicking the right-hand mouse button on the 
header column hides that column. To display the hidden column, select the column from the said 
popup menu again. Dragging the column with the mouse can change the display order. 

5.6.3 Specifying Trace Acquisition Conditions 

The capacity of the trace buffer is limited. When the buffer becomes full, the oldest trace 
information is overwritten. Setting the trace acquisition condition allows acquisition of useful 
trace information and effective use of the trace buffer. 

The trace acquisition condition is set in the [Acquisition] dialog box that is displayed by selecting 
[Acquisition…] from the popup menu. 

Settings other than those in the [Display Type] group box are common to the High-performance 
Embedded Workshops for CPU0 and CPU1. Settings in the [Display Type] group box are not 
common to the High-performance Embedded Workshops for CPU0 and CPU1. 

The [Acquisition] dialog box has the following pages: 

Table 5.1 [Acquisition] Dialog Box Pages 

Page Item 

[Trace mode] Sets trace acquisition conditions. 

[AUD Trace (CPU0)] Sets the AUD trace conditions for CPU0. *1*2 

[AUD Trace (CPU1)] Sets the AUD trace conditions for CPU1. *1*2 

Notes: 1. This dialog box is not supported by the products that do not support the AUD trace 
function. 

 2. Some products do not support this page. For details, refer to the online help for each 
product. 
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(1) [Trace mode] page 

Sets trace acquisition conditions. 

 

 

Figure 5.19   [Acquisition] Dialog Box ([Trace mode] Page) 

This dialog box specifies the methods and conditions for the acquisition of trace information. 
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The following items can be set: 

[Trace mode]:   Set the trace mode conditions 

   [Trace Type]: Selects the type of trace function.                                                                              
             [I-Trace]:               The internal trace function is used. 
             [AUD function]:        The AUD trace function is used. 
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• [Trace mode] page for internal trace ([I-trace] selected) 

 

Figure 5.20   [Acquisition] Dialog Box (when I-trace has been selected) 
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This dialog box is used to specify conditions for the acquisition of trace information. 

When [I-Trace] has been selected: 

[I-Trace mode]: Set the bus and other conditions for acquisition of the internal trace. 

 

[Channel 1] : Set the trace acquisition conditions for channel 1.  The same conditions 
cannot be set for channels 1 and 2. 

[Type] [M-Bus & Branch, CPU0] : Trace information is acquired with M-bus 
access and branching by CPU0 as 
conditions. 

 [I-Bus, CPU0] : Trace information is acquired with I-bus 
access by CPU0 as condition. 

 [F-Bus, CPU0] : Trace information is acquired with F-bus 
access by CPU0 as a condition.  

 [M-Bus & Branch, CPU1] : Trace information is acquired with M-bus 
access and branching by CPU1 as 
conditions. 

 [I-Bus, CPU1] : Trace information is acquired with I-bus 
access by CPU1 as a condition. 

 [F-Bus, CPU1] : Trace information is acquired with F-bus 
access by CPU1 as a condition. 

 [DMAC] : Acquires trace information on access by 
the DMAC. 

[Channel 2] : Set the trace acquisition conditions for channel 2. The same conditions 
cannot be set for channels 1 and 2. 

[Type] [M-Bus & Branch, CPU0] : Trace information is acquired with M-bus 
access and branching by CPU0 as 
conditions. 
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[I-Bus, CPU0] : Trace information is acquired with I-bus 
access by CPU0 as a condition. 

[F-Bus, CPU0] : Trace information is acquired with F-bus 
access by CPU0 as a condition. 

[M-Bus & Branch, CPU1] : Trace information is acquired with M-bus 
access and branching by CPU1 as 
conditions. 

 [I-Bus, CPU1] : Trace information is acquired with I-bus 
access by CPU1 as a condition. 

 [F-Bus, CPU1] : Trace information is acquired with F-bus 
access by CPU1 as a condition. 

 [None] : No conditions are set. 

: Set the conditions for acquisition of the internal trace information. [Acquisition] 

[Read] : Trace information is acquired on  reading. 

 [Write] : Trace information is acquired on  writing. 

 [PC relative addressing] : Trace information is acquired with the 
execution address. 

 [Branch] : Trace information is acquired on the 
branch. 

 [Software] : Software tracing is a condition. 

 [Data access] : Trace information is acquired on data 
access 

 [Instruction Fetch] : Trace information is acquired on cycles of 
instruction fetching. 

[When trace 
buffer full] 

: Specify the operation when the trace buffer is completely full. 
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 [Trace continue] : Keep acquiring trace information. The 
earliest contents of the trace buffer are 
overwritten. 

 [Trace stop] : Stop trace acquisition. 

 [Break (CPU0)] : Break CPU0. 

 [Break (CPU1)] : Break CPU1. 

 [Break (CPU0, CPU1)] : Break CPU0 and CPU1. 
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• [Trace mode] page for internal trace ([AUD function] selected) 

  

Figure 5.21   [Acquisition] Dialog Box (when AUD function has been selected) 
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When [AUD function] has been selected   

: Selection of realtime or non-realtime trace acquisition 

[Realtime trace] : When a next branch is encountered while 
trace can be replaced by the latest trace 
information to be acquired. Thus, while the 
user program is executed in realtime, the 
acquisition of some trace information 
might not be possible. 

[AUD mode1] 

[Non realtime trace] : When a next branch is encountered while 
trace information is being acquired, CPU 
operation is suspended until acquisition of 
the trace information is completed. The 
user program is thus not executed in 
realtime. 

[AUD mode2] : Specify the operation when the trace buffer is completely full. 

 [Trace continue] : Continue trace acquisition. The earliest 
trace information will be overwritten. 

 [Trace stop] : Once the trace buffer is full, trace 
information is not acquired. 

[AUD trace 
display range] 

: Specify the range for which AUD trace information will be displayed. 

[Start pointer] : Set the pointer to the start of the range for 
AUD tracing. 

[End pointer] : Set the pointer to the end of the range for 
AUD tracing. 

⎯ Common to [I-Trace]/ [AUD function] 

[Display Type] Specify the information to be displayed in the trace window. 

 [CPU0] : Display the trace information for which 
the CPU identifier (CPU ID) is CPU0. 

 [CPU1] : Display the trace information for which 
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the CPU identifier (CPU ID) is CPU1. 

 [DMAC] : Display the trace information for which 
the CPU identifier (CPU ID) is DMA. 
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(2) [AUD Trace(CPU0)] or [AUD Trace(CPU1)] page 

 

Figure 5.22   [Acquisition] Dialog Box ([AUD Trace (CPU0)] Page) 
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The settings of either the AUD trace (CPU0) or the AUD trace (CPU1) 

Select the AUD trace conditions from the [Trace Settings] when the AUD function is selected. 

[Branch trace] : Trace information is acquired by the branch source and the branch 
destination as conditions. 

[Window trace] : Window trace functions. Memory access information is acquired 
within the specified area. 

 [Channel A] : Set whether acquire the 
window trace information 
from channel A or not. 

 [Channel B] : Set whether acquire the 
window trace information 
from channel B or not. 

[Software trace] : Software trace functions. Trace is acquired with the software trace 
instructions. 

When checking on the [Branch trace] of the [Trace settings], select the acquisition branch 
conditions.  

[Acquire normal branch instruction trace] : Specify the normal branch as 
the branch conditions. 

[Acquire subroutine instruction trace]  : Specify the subroutine branch 
as the branch conditions. 

[Acquire exception branch instruction trace] : Select the exception branch. 

When checking on the [Window trace] of the [Trace settings], set the conditions for [Channel A] 
and [Channel B] of the [Window trace] group box. 

[Channel A]  : Set the conditions to acquire the AUD trace. 

 [Read/Write] : Sets tracing of read or write access or both. 

  [Read] : Trace information is acquired 
on reading.  

   

[Write] 

 

: Trace information is acquired   
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on writing.  

  [Read/Write] : Trace information is acquired 
on reading and writing. 

 [Start address] : Sets an address range for the tracing of data 
access. The start address is set here. 

 [End address] : Sets an address range for the tracing of data 
access. The end address is set here. 

 [Bus state] : Sets a bus to acquire the window trace. 

  [M-Bus] : Select the M-Bus. 

  [DMAC] : Select the DMA. 

[Channel B]  Set the conditions to acquire the AUD trace. 

 [Read/Write]           : Sets tracing of read or write access or both. 

  [Read] : Trace information is acquired 
on reading.  

  [Write] : Trace information is acquired 
on writing.  

  [Read/Write] : Trace information is acquired 
on reading and writing.  

 [Start address] : Sets an address range for the tracing of data 
access. The end address is set here. 

 [End address] : Sets an address range for the tracing of data 
access. The end address is set here. 

 [Bus state] : Sets a bus to acquire the window trace. 

  [M-Bus] : Select the M-Bus. 

  [DMAC] : Select the DMA. 
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5.6.4 Searching for a Trace Record 

Use the [Trace Find] dialog box to search for a trace record. To open this dialog box, choose 
[Find...] from the popup menu. 

These settings are not common to the High-performance Embedded Workshops for CPU0 and 
CPU1. That is, each High-performance Embedded Workshop has its own settings. 

The [Trace Find] dialog box has the following options: 

Table 5.2 [Trace Find] Dialog Box Pages 

Page Description 

[General] Sets the range for searching. 

[Address] Sets an address condition. 

[Data] Sets a data condition. 

[Type] Selects the type of trace information. 

[Bus] Selects the type of a bus. 

[R/W] Selects the type of access cycles. 

[Size] Selects a unit of access. 

Note: Items other than [General] and [Address] vary according to the emulator in use. For details, 
refer to the online help. 

 

Clicking the [OK] button after setting conditions in those pages stores the settings and starts 
searching. Clicking the [Cancel] button closes this dialog box without setting conditions. 

When a trace record that matches the search conditions is found, the line for the trace record will 
be highlighted. When no matching trace record is found, a message dialog box will appear. 

Only the trace information that satisfies all the conditions set in above pages will be searched. 

If a search operation is successful, selecting [Find Next] from the popup menu will move to the 
next found item. 
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(1) [General] page 

Set the range for searching. 

 

Figure 5.23   [Trace Find] Dialog Box ([General] Page) 

[Trace search range]: Sets the range for searching. 

[No]: Searches for information that does not match the conditions 
set in other pages when this box is checked. 

[Upper search]:  Searches upwards when this box is checked. 

[Start pointer]:  Enters a PTR value to start a search. 

[End pointer]:  Enters a PTR value to end a search. 

Note: Along with setting the range for searching, PTR values to start and end searching can be 
set in the [Start PTR] and [End PTR] options, respectively. 
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(2) [Address] page 

Set address condition. 

 

Figure 5.24   [Trace Find] Dialog Box ([Address] Page) 

[Don't care]: Detects no address when this box is checked. 

[Setting]: Detects the specified address. 

[Value]: Enter the address value (not available when [Don’t care] has been 
checked). 
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(3) [Data] page 

Set a data condition. 

 

Figure 5.25   [Trace Find] Dialog Box ([Data] Page) 

[Don't care]: Detects no data when this box is checked. 

[Setting]: Detects the specified data. 

[Value]: Enter the data value (not available when [Don’t care] has been checked). 
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(4) [R/W] page 

Select the type of access cycles. 

 

Figure 5.26   [Trace Find] Dialog Box ([R/W] Page) 

[Don't care]: Detects no read/write condition when this box is checked. 

[Setting]: Detects the specified read/write condition. 

[String]: Select a read/write condition (not available when [Don’t care] has been 
checked). 
 READ: Read cycle 
 WRITE: Write cycle 
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(5) [Type] page 

Select the type of Trace information. 

 

Figure 5.27   [Trace Find] Dialog Box ([Type] Page) 

[Don't care]: Detects no type condition when this box is checked. 

[Setting]: Detects the specified type condition. 

[String]: Select a type condition (not available when [Don’t care] has been 
checked). 
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(6) [Size] page 

Select a unit of access. 

 

Figure 5.28   [Trace Find] Dialog Box ([Size] Page) 

[Don't care]: Detects no size condition when this box is checked. 

[Setting]: Detects the specified size condition. 

[String]: Select a size condition (not available when [Don’t care] has been 
checked). 
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5.6.5 Clearing the Trace Information 

When [Clear] is selected from the popup menu, the trace buffer that stores the trace information 
becomes empty. If several [Trace] windows are open, all [Trace] windows will be cleared as they 
all access the same buffer. 

5.6.6 Saving the Trace Information in a File 

Select [Save...] from the popup menu to open the [Save As] file dialog box, which allows the user 
to save the information displayed in the [Trace] window as a text file. A range can be specified 
based on the [PTR] number (saving the complete buffer may take several minutes). Note that this 
file cannot be reloaded into the [Trace] window. 

Note: In filtering of trace information, the range to be saved cannot be selected. All the trace 
information displayed in the [Trace] window after filtering will be saved. Select a filtering 
range on the [General] page in the [Trace Filter] dialog box if you want to save the 
selected range. For details on the filtering function, refer to section 5.6.10, Extracting 
Records from the Acquired Information. 

5.6.7 Viewing the [Editor] Window 

The [Editor] window corresponding to the selected trace record can be displayed in the following 
two ways: 

• Select a trace record and choose [View Source] from the popup menu. 

• Double-click a trace record. 
 
The [Editor] or [Disassembly] window opens and the selected line is marked with a cursor. 

5.6.8 Trimming the Source 

Choose [Trim Source] from the popup menu to remove the white space from the left side of the 
source. 

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu. 
To restore the white space, choose [Trim Source] while the check mark is shown. 
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5.6.9 Temporarily Stopping Trace Acquisition 

To temporarily stop trace acquisition during execution of the user program, select [Halt] from the 
popup menu. This stops trace acquisition and updates the trace display. Use this method to check 
the trace information without stopping execution of the user program. 

5.6.10 Extracting Records from the Acquired Information 

Use the filtering function to extract the records you need from the acquired trace information. The 
filtering function allows the trace information acquired by hardware to be filtered by software. 
Unlike the settings made in the [Trace Acquisition] dialog box for acquiring trace information by 
conditions, changing the settings for filtering several times to filter the acquired trace information 
allows easy extraction of necessary information, which is useful for analysis of data. The content 
of the trace buffer will not be changed even when the filtering function is used. Acquiring useful 
information as much as possible by the [Trace Acquisition] settings improves the efficiency in 
analysis of data because the capacity of the trace buffer is limited. 

Use the filtering function in the [Trace Filter] dialog box. To open the [Trace Filter] dialog box, 
select [Filter…] from the popup menu.Selects a unit of access 

These settings are not common to the High-performance Embedded Workshops for CPU0 and 
CPU1. That is, each High-performance Embedded Workshop has its own settings. 

The [Trace Filter] dialog box has the following pages: 

Table 5.3 [Trace Filter] Dialog Box Pages 

Page Description 

[General] Selects the range for filtering. 

[Address] Sets an address condition. 

[Data] Sets a data condition. 

[Type] Selects the type of trace information. 

[Bus] Selects the type of a bus. 

[R/W] Selects the type of access cycles. 

[Size] Selects a unit of access. 

Note: Items other than [General] and [Address] vary according to the emulator in use. For details, 
refer to the online help. 

 



Section 5   Debugging 

  Rev. 1.00  Nov. 26, 2007  Page 133 of 230 

                                                                                       REJ10J1766-0100 

Set filtering conditions and then press the [OK] button. This starts filtering according to the 
conditions. Clicking the [Cancel] button closes the [Trace Filter] dialog box, which holds the 
settings at the time when the dialog box was opened.  

In filtering, only the trace information that satisfies one or more filtering conditions set in the 
above pages will be displayed in the [Trace] window.  

Filtering conditions can be changed several times to analyze data because the content of the trace 
buffer is not changed by filtering. 

(1) [General] page 

Set the range for filtering. 

 

Figure 5.29   [Trace Filter] Dialog Box ([General] Page) 

[Don't care other pages]: Only selects the cycle number when this box is checked. Other options 
become invalid. 

[Enable Filter]: Enables the filter when this box is checked. 

[Not designation]: Filters information that does not match the conditions set in those pages 
when this box is checked. 

[Trace display range]: Sets the range for filtering. 
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[Start PTR]:  Enters a PTR value to start filtering. 
[End PTR]:  Enters a PTR value to end filtering. 

Note: Along with setting the range for filtering, PTR values to start and end filtering can be set 
in the [Start PTR] and [End PTR] options, respectively. 

 

(2) [Address] page 

Set an address condition. 

 

Figure 5.30   [Trace Filter] Dialog Box ([Address] Page) 

[Don't care]: Detects no address when this box is checked. 

[Setting]: Detects the specified address. 

 [Point]: Specifies a single address (not available when [Don’t care] has been checked). 

[Range]: Specifies an address range (not available when [Don’t care] has been checked). 

[From]: Enter a single address or the start of the address range (not available when 
[Don’t care] has been checked). 

[To]: Enter a single address or the end of the address range (only available when 
[Range] has been selected). 
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Note: Along with setting the address range, the start and end of the address range can be set in 
the [From] and [To] options, respectively. 

 

(3) [Data] page 

Set a data condition. 

 

Figure 5.31   [Trace Filter] Dialog Box ([Data] Page) 

[Don't care]: Detects no data when this box is checked. 

[Setting]: Detects the specified data. 

 [Point]: Specifies single data (not available when [Don’t care] has been checked). 

[Range]: Specifies a data range (not available when [Don’t care] has been checked). 

[From]: Enter single data or the minimum value of the data range (not available when 
[Don’t care] has been checked). 

[To]: Enter the maximum value of the data range (only available when [Range] has 
been selected). 

Note: Along with setting the data range, the minimum and maximum values can be set in the 
[From] and [To] options, respectively. 
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(4) [R/W] page 

Select the type of access cycles. 

 

Figure 5.32   [Trace Filter] Dialog Box ([R/W] Page) 

[Don't care]: Detects no read/write condition when this box is checked. 

[Setting]: Detects the specified read/write condition. 

READ: Detects read cycles when this box is checked (not available when 
[Don’t care] has been checked). 

WRITE: Detects write cycles when this box is checked (not available when 
[Don’t care] has been checked). 
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(5) [Type] page 

Select the type of Trace information. The selection is not available when a time stamp is acquired. 

 

Figure 5.33   [Trace Filter] Dialog Box ([Type] Page) 

[Don't care]: Detects no type condition when this box is checked. 

[Setting]: Detects the specified type condition (not available when [Don’t care] has been 
checked). 
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(6) [Size] page 

Select a unit of the access. 

 

Figure 5.34   [Trace Filter] Dialog Box ([Bus] Page) 

[Don't care]: Detects no size condition when this box is checked. 

[Setting]: Detects the specified size condition (not available when [Don’t care] has been 
checked). 
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5.6.11 Analyzing Statistical Information 

Choose [Statistic…] from the popup menu to open the [Statistic] dialog box and analyze statistical 
information under the specified conditions. 

 

Figure 5.35   [Statistic] Dialog Box 

[Statistic Analysis]: Setting required for analysis of statistical information. 

 [Default]: Sets a single input value or character string. 

[Range]:  Sets the input value or character string as a range. 

[Item]:  Sets the item for analysis. 

[Start]: Sets the input value or character string. To set a range, the start value 
must be specified here. 
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[End]: Specify the end value if a range has been set (only available when 
[Range] has been selected). 

[Set]:  Adds a new condition to the current one. 

[New]:  Creates a new condition. 

[Result] button: Obtains the result of statistical information analysis. 

[Clear]:  Initializes the settings. 

[Result] list box: Displays all conditions and results of statistical information analysis. 

[Close]: Closes this dialog box. All the results displayed in the [Result] list will 
be cleared. 

This dialog box allows the user to analyze statistical information concerning the trace information. 
Set the target of analysis in [Item] and the input value or character string by [Start] and [End]. 
Click the [Result] button after setting a condition by pressing the [New] or [Add] button to 
analyze the statistical information and display its result in the [Result] list. 

Note: In this emulator, only [PTR] can be set as a range. Each of other items must be specified 
as a character string. In analysis of statistical information, character strings are compared 
with those displayed in the [Trace] window. Only those that completely match are 
counted. Note, however, that this test is not case sensitive. The number of blanks will not 
be cared either. 
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5.6.12 Extracting Function Calls from the Acquired Trace Information 

To extract function calls from the acquired trace information, select [Function Call…] from the 
popup menu. The [Function Call Display] dialog box will be displayed. 

 

Figure 5.36   [Function Call Display] Dialog Box 

[Setting]: Selects whether or not to extract function calls. 

 [Enable]: Extracts function calls. 

 [Disable]: Does not extract function calls. 

When [Enable] is selected, only the cycles that include function calls are extracted for display 
from the acquired trace information. The content of the trace buffer is not changed by extraction of 
function calls. Using this function for the trace information that includes function calls allows the 
user to know the order of function calls. 
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5.7 Analyzing Performance 

Use the performance analysis function to measure execution performance. The performance 
analysis function does not affect the realtime operation because it measures execution performance 
in the specified range by using the on-chip circuit for performance measurement. 

These settings are not common to the High-performance Embedded Workshops for CPU0 and 
CPU1. That is, each High-performance Embedded Workshop has its own settings. 

Note: The measurement conditions and the number of channels differ depending on the product. 

5.7.1 Opening the [Performance Analysis] Window 

Choose [View -> Performance -> Performance Analysis] or click the [PA] toolbar button ( ) to 
open the [Select Performance Analysis Type] dialog box. 

 

Figure 5.37   [Select Performance Analysis Type] Window 

Click the [OK] button to open the [Performance Analysis] window. 
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Figure 5.38   [Performance Analysis] Window 

It is possible to hide any column not necessary in the [Performance Analysis] window. Selecting a 
column you want to hide from the popup menu displayed by clicking the right-hand mouse button 
on the header column hides that column. To display the hidden column, select the column from 
the said popup menu again. 

5.7.2 Setting Conditions for Measurement 

Conditions for measurement can be displayed and changed in the [Performance Analysis] window. 
Select a point where a condition is to be set, and then select [Set…] from the popup menu to 
display the [Performance Analysis Properties] dialog box. 

5.7.3 Starting Performance Data Acquisition 

Executing the user program clears the result of previous measurement and automatically starts 
measuring execution performance according to the conditions that have been set. Stopping the user 
program displays the result of measurement in the [Performance Analysis] window. 

5.7.4 Deleting a Measurement Condition 

Select [Reset] from the popup menu with a measurement condition selected to delete the 
condition. 
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5.7.5 Deleting All Measurement Conditions 

Choose [Reset All] from the popup menu to delete all the conditions that have been set. 

 

 

5.8 Synchronizing Multiple Debugging Platforms 

Multiple debugging platforms can be operated at the same time in the High-performance 
Embedded Workshop. Initiating a High-performance Embedded Workshop from another High-
performance Embedded Workshop synchronizes multiple debugging platforms. The High-
performance Embedded Workshop that initiates another High-performance Embedded Workshop 
is called the master, and the initiated High-performance Embedded Workshop is called the slave. 
Choose [Tools -> Launch Slave HEW...] or click the [Launch Slave HEW] toolbar button ( ) to 
initiate a slave High-performance Embedded Workshop. 

The slave High-performance Embedded Workshop has the same functionality as the master High-
performance Embedded Workshop. 

The slave High-performance Embedded Workshop is notified of the following actions done in the 
master High-performance Embedded Workshop to ensure synchronization of the slave High-
performance Embedded Workshop and the master High-performance Embedded Workshop. 

• Reset go 

• Go 

• Stop debugging 
 
Note: The master High-performance Embedded Workshop can initiate multiple slave High-

performance Embedded Workshop applications, but slave High-performance Embedded 
Workshop applications cannot be nested (no slave High-performance Embedded 
Workshop can initiate another slave High-performance Embedded Workshop). 

When selecting [Renesas High-performance Embedded Workshop] -> [High-performance 
Embedded Workshop] from [Programs] in the [Start] menu to initiate another High-performance 
Embedded Workshop, two emulators can be used separately for debugging. 
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5.8.1 Distinguishing Two Emulators 

Connect two emulators to the USB connector. Then, initiate the High-performance Embedded 
Workshop using the tutorial workspace. The following message is displayed. 

 

Figure 5.39   Message for Driver Selection 

Click the [OK] button. The following dialog box will appear. 

 

Figure 5.40   [Driver Details] Dialog Box (1) 

Select [Renesas E-Series USB Driver] from the [Driver] drop-down list box and open the 
[Channel] drop-down list box. Channel information for two emulators is displayed in the 
[Channel] drop-down list box as shown in figure 5.41. 
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Figure 5.41   [Driver Details] Dialog Box (2) 

Information displayed in figure 5.41 is the information of the USB connector to which the 
emulators are connected. 

Note: The displayed character strings of the information differ according to the host computer’s 
environment. 

Check which of the character strings of information show emulators. 

Select [<no driver selected>] in the [Driver] drop-down list box and disconnect one emulator from 
the USB connector. After that, select [Renesas E-Series USB Driver] in the [Driver] drop-down 
list box. Only information on the USB connector that the emulator is connected to is displayed in 
the [Channel] drop-down list box. 

The above procedures are used to discern which of the emulators are indicated by the displayed 
character strings of information in the [Channel] drop-down list box. 

When initiating the High-performance Embedded Workshop, in the [Channel] drop-down list box, 
select the information on the USB connector of the emulator that is connected to the master CPU. 
Initiate the High-performance Embedded Workshop using the normal procedures. 

When initiating the slave High-performance Embedded Workshop, in the [Channel] drop-down 
list box, select the information on the USB connector of the emulator that is connected to the slave 
CPU.



Section 6   Tutorial 

  Rev. 1.00  Nov. 26, 2007  Page 147 of 230 

                                                                                       REJ10J1766-0100 

Section 6   Tutorial 

6.1 Introduction 

This section describes the main functions of the emulator by using a tutorial program. 

Explanations where something else is not stated apply to operations of the High-performance 
Embedded Workshop for CPU1. The tutorial program is written in C++ and runs through the 
High-performance Embedded Workshops for CPU0 and CPU1 to sort ten random data items into 
ascending or descending order. The tutorial program performs the following actions: 

• The main function generates random data to be sorted. 

• The sort function sorts the generated random data in ascending order. 

• The change function then sorts the data in descending order. 
 
The file tutorial.cpp contains source code for the tutorial program.  The file 
Tutorial.abs is a compiled load module in the Elf/Dwarf2 format. 

Notes: 1. Operation of Tutorial.abs is big endian.  For little-endian operation, 
Tutorial.abs must be recompiled.  After recompilation, the addresses may differ 
from those given in this section. 

2. This section describes general usage examples for the emulator.  For the specifications 
of particular products, refer to the additional document, Supplementary Information 
on Using the SHxxxx, or the online help. 

3. The operation address of Tutorial.abs attached to each product differs depending 
on the product.  Replace the address used in this section with upper 16 bits of the 
actually loaded address. 
Example: Although the PC address is H’0000006c in the manual, enter H’0C00xxxx 
when the loaded address of Tutorial.abs is H’0C00006c (upper bit H’0000 is 
changed to H’0C00). 

4. When using the MCU with flash memory, specify the end address of the internal 
RAM for the stack pointer (SP). The internal RAM area differs depending on the 
MCU. Refer to the hardware manual of the MCU used. 

5. The displayed addresses and data may differ from those given in this section 
depending on the MCU to be used. 
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6.2 Running the High-performance Embedded Workshop 

To run the High-performance Embedded Workshop for the CPU0 and CPU1, refer to section 3.10, 
System Check. 

6.3 Setting up the Emulator 

The clocks which are used for data communications must be set up on the emulator before the 
program is downloaded. 

• AUD clock 

A clock used in acquiring AUD traces. 

If its frequency is set too low, complete data may not be acquired during realtime tracing. 

Set the frequency not to exceed the upper limit for the MPU’s AUD clock. 

The AUD clock is only needed for using emulators that have an AUD trace function. 

• JTAG (H-UDI) clock (TCK) 

A communication clock used except for acquiring AUD trace. 

If its frequency is set too low, the speed of downloading will be lowered. 

Set the frequency not to exceed the upper limit for the MPU’s guaranteed TCK range. 

For details of the limitations on both clocks, refer to section 2.2.3, Notes on Using the JTAG 
(H-UDI) Clock (TCK) and AUD Clock (AUDCK), in the additional document, Supplementary 
Information on Using the SHxxxx.   

 
The following is a description of the procedure used to set the clocks. 
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6.4 Setting the [Configuration] Dialog Box 

• Select [Emulator] then [Systems…] from the [Setup] menu in the High-performance 
Embedded Workshop for CPU1 to set a communication clock.  The [Configuration] dialog box 
is displayed. 

 

 

Figure 6.1   [Configuration] Dialog Box 

• Set appropriate values in the [AUD clock] and [JTAG clock] combo boxes.  The clock also 
operates with the default value. 

 
Note: The items that can be set in this dialog box differ according to the product.  For details on 

the settings for each product, refer to the online help. 

• Click the [OK] button to set a configuration. 
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6.5 Checking the Operation of the Target Memory for Downloading 

Check that the destination memory area for downloading is operating correctly. 

When the destination memory is SDRAM or DRAM, a register in the bus controller of the MPU 
must be set before downloading.  Set the bus controller correctly in the [IO] window according to 
the memory type to be used. 

When the required settings, such as the settings for the bus controller, have been completed, 
display and edit the contents of the destination memory in the [Memory] window in the High-
performance Embedded Workshop for CPU1 to check that the memory is operating correctly. 

Note: The above way of checking the operation of memory may be inadequate.  It is 
recommended that a program for checking the memory be created. 

• Select [Memory…] from the [CPU] submenu of the [View] menu and enter H’00000000, 
H’00000000, and H’FFFFFFFF in the [Display address], [Scroll Start Address], and 
[Scroll End Address] edit boxes, respectively. 

 

 

Figure 6.2   [Display Address] Dialog Box 

• Click the [OK] button.  The [Memory] window is displayed and shows the specified memory 
area. 
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Figure 6.3   [Memory] Window 

• Placing the mouse cursor on a point in the display of data in the [Memory] window and 
double-clicking allows the values at that point to be changed. Data can also be directly edited 
around the current position of the text cursor. 
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6.6 Downloading the Tutorial Program 

6.6.1 Downloading the Tutorial Program 

Download the object program to be debugged. 

To proceed with source-level debugging with the High-performance Embedded Workshop for 
CPU0 or the High-performance Embedded Workshop for CPU1, download the debugging 
information file for the corresponding CPU.  

• Select [Download module] from [Tutorial.abs] under [Download modules]. 
 

 

Figure 6.4   Downloading the Tutorial Program 
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6.6.2 Displaying the Source Program 

The High-performance Embedded Workshop allows the user to debug a user program at the 
source level. 

• Double-click [tutorial.cpp] under [C++ source file] in the High-performance Embedded 
Workshop for CPU1. 
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Figure 6.5   [Editor] Window (Displaying the Source Program) 

Select a font and size that are legible from the [Format…] option in the [Setup] menu if necessary. 

 
Initially the [Editor] window shows the start of the user program, but the user can use the scroll 
bar to scroll through the user program and look at the other statements. 
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6.7 Setting a PC Breakpoint 

A PC breakpoint is a simple debugging function. 

The [Editor] window provides a very simple way of setting a PC breakpoint at any point in a 
program.  For example, to set a PC breakpoint at the sort function call: 

• Select by double-clicking the [S/W breakpoint] column on the line containing the sort 
function call in the High-performance Embedded Workshop for CPU1. 
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Figure 6.6   [Editor] Window (Setting a PC Breakpoint) 

The symbol • will appear on the line containing the sort function.  This shows that a PC 
breakpoint has been set. 

 
Note: The PC breakpoint cannot be set in the ROM area. 
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6.8 Setting Registers 

Set values of the program counter and the stack pointer before executing the program. 

• Select [Registers] from the [CPU] submenu of the [View] menu in the High-performance 
Embedded Workshop for CPU0 and CPU1.  The [Register] window is displayed. 

 

 

Figure 6.7   [Register] Window 
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• To change the value of the program counter (PC), double-click the value area in the [Register] 
window with the mouse.  The following dialog box is then displayed, and the value can be 
changed.  Set the program counter to H’00000800 in this tutorial program, and click the [OK] 
button. 

 

 

Figure 6.8   [Register] Dialog Box (PC) 

• Change the value of the stack pointer (SP) in the same way.  Set H’FFF90000 for the value of 
the stack pointer in this tutorial program. 
When using the MCU with flash memory, specify the end address of the internal RAM for the 
stack pointer (SP). The internal RAM area differs depending on the MCU. Refer to the 
hardware manual of the MCU used. 

 

 

Figure 6.9   [Register] Dialog Box (R15) 
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6.9 Executing the Program 

Execute the program as described in the following: 

• Since the [Go] check box under [Synchronization options] in the [Configuration] dialog box is 
enabled, execute the program by selecting [Go] from the [Debug] menu of the High-
performance Embedded Workshop for CPU1, and then selecting [Go] from the [Debug] menu 
or selecting the [Go] button on the toolbar of the High-performance Embedded Workshop for 
CPU0. 

 

 

Figure 6.10   [Go] Button 

Once program execution has started, ‘**RUNNING’ will be displayed on the status bar, and will 
be accompanied by the PC value (address) of the function being executed in the case of products 
that support acquisition of the CPU state.  The program will be executed up to any breakpoint that 
has been set in the High-performance Embedded Workshop for CPU1, and an arrow will be 
displayed in the [S/W breakpoint] column to indicate the position where the program was 
suspended, with the message [BREAKPOINT] in the status bar. 

Notes: 1. When the source file is displayed after a break, a path of the source file may be 
inquired. The location of the source file is as follows: 
<Drive where the OS has been installed>: 
\WorkSpace\Tutorial\E10A-USBM\SH2A-DUAL\SH2A-DUAL\Tutorial_SH2A-
DUAL\CPU1. 

 2. If program execution is failed, select [Reset CPU] from the [Debug] menu, reset the 
device, and restart the procedure from figure 6.8. 
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Figure 6.11   [Editor] Window (Break State) 
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The user can see the cause of the break that occurred last time in the [Status] window. 

• Select [Status] from the [CPU] submenu of the [View] menu.  After the [Status] window is 
displayed, open the [Platform] sheet, and check the Status of Cause of last break. 

 

 

Figure 6.12   [Status] Window 

Note: The items that can be displayed in this window differ according to the product.  For the 
items that can be displayed, refer to the online help. 
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6.10 Reviewing Breakpoints 

The user can see all the breakpoints set in the program in the [Event] window. 

• Select [Eventpoints] from the [Code] submenu of the [View] menu of the High-performance 
Embedded Workshop for CPU1.  The [Event] window is displayed.  Select the [Breakpoint] 
sheet. 

 

 

Figure 6.13   [Event] Window 

The popup menu, opened by clicking the [Event] window with the right-hand mouse button, 
allows the user to set or change breakpoints, define new breakpoints, and delete, enable, or 
disable breakpoints. 
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6.11 Referring to Symbols 

The [Label] window can be used to display the information on symbols in modules. 

Select [Label] from the [Symbol] submenu of the [View] menu of the High-performance 
Embedded Workshop for CPU1. The [Label] window is displayed so that the user can refer to the 
addresses of symbols in modules. 

 

Figure 6.14   [Label] Window 
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6.12 Viewing Memory 

When the label name is specified, the user can view the memory contents that the label has been 
registered in the [Memory] window.  For example, to view the memory contents corresponding to 
_main in word size: 

• Select [Memory …] from the [CPU] submenu of the [View] menu in the High-performance 
Embedded Workshop for CPU1, enter _main in the [Display Address] edit box, 00000000 
in the [Scroll Start Address] edit box, and FFFFFFFF in the [Scroll End Address] edit box. 

 

 

Figure 6.15   [Display Address] Dialog Box 

• Click the [OK] button. The [Memory] window showing the specified area of memory is 
displayed. 

 

 

Figure 6.16   [Memory] Window 
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6.13 Watching Variables 

As the user steps through a program, it is possible to watch that the values of variables used in the 
user program are changed.  For example, set a watch on the long-type array a declared at the 
beginning of the program, by using the following procedure: 

• Place the cursor in the column to the left of where array a is displayed in the [Editor] window 
of the High-performance Embedded Workshop for CPU1. 

• Click the right-hand mouse button and select [Instant Watch...]. 

The following dialog box will be displayed. 

 

Figure 6.17   [Instant Watch] Dialog Box 

• Click the [Add] button to add a variable to the [Watch] window. 
 

 

Figure 6.18   [Watch] Window (Displaying the Array) 
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The user can also add variables to the [Watch] window by specifying those name. 

• Click the [Watch] window with the right-hand mouse button and select [Add Watch…] from 
the popup menu. 

 
The following dialog box will be displayed.  Enter variable p_sam. 

 

Figure 6.19   [Add Watch] Dialog Box 

• Click the [OK] button. 
 
The [Watch] window will now also show the instance p_sam. 

 

Figure 6.20   [Watch] Window (Displaying the Variables) 
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The user can click mark ‘+’ at the left side of array a in the [Watch] window to watch all the 
elements. 

 

Figure 6.21   [Watch] Window (Displaying Array Elements) 
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6.14 Displaying Local Variables 

The user can display local variables in a function using the [Locals] window.  For example, we 
will examine the local variables in the main function, which declares four local variables: a, j, i, 
and p_sam. 

• Select [Locals] from the [Symbol] submenu of the [View] menu of the High-performance 
Embedded Workshop for CPU1.  The [Locals] window is displayed. 

 
The [Locals] window shows the local variables in the function currently pointed to by the program 
counter, along with their values. Note, however, that the [Locals] window is initially empty 
because local variables are yet to be declared. 

 

Figure 6.22   [Locals] Window 

• Click mark ‘+’ at the left side of array a in the [Locals] window to display the elements. 

• Refer to the elements of array a before and after the execution of the sort function, and 
confirm that random data is sorted in descending order. 
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6.15 Stepping Through a Program 

The High-performance Embedded Workshop provides a range of step menu commands that allow 
efficient program debugging. 

Table 6.1 Step Option 

Menu 
Command 

Description 

Step In Executes each statement, including statements within functions. 

Step Over Executes a function call in a single step. 

Step Out Steps out of a function, and stops at the statement following the statement in the 
program that called the function. 

Step… Steps the specified times repeatedly at a specified rate. 

 

6.15.1 Executing [Step In] Command 

The [Step In] command steps into the called function and stops at the first statement of the called 
function. 

• To step through the sort function, select [Step In] from the [Debug] menu in the High-
performance Embedded Workshop for CPU1, or click the [Step In] button on the toolbar. After 
that, select [Go] from the [Debug] menu of the High-performance Embedded Workshop for 
CPU1, or click on the [Go] button on the toolbar. These operations will perform synchronized 
step in. 

 

 

Figure 6.23   [Step In] Button 
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Figure 6.24   [Editor] Window (Step In) 

• The highlighted line moves to the first statement of the sort function in the [Editor] window 
in the High-performance Embedded Workshop for CPU1. 
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6.15.2 Executing [Step Out] Command 

The [Step Out] command steps out of the called function and stops at the next statement of the 
calling statement in the main function. 

To step out of the sort function, select [Step Out] from the [Debug] menu in the High-performance 

Embedded Workshop for CPU1, or click the [Step Out] button on the toolbar.  After that, select [Go] from 

the [Debug] menu of the High-performance Embedded Workshop for CPU0, or click on the [Go] button on 

the toolbar. 

Note: It takes time to execute this function.  When the calling source is clarified, use [Go To 
Cursor]. 

 

Figure 6.25   [Step Out] Button 
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Figure 6.26   [High-performance Embedded Workshop] Window (Step Out) 

The data of variable a displayed in the [Watch] window is sorted in ascending order. 
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6.15.3 Executing [Step Over] Command 

The [Step Over] command executes a function call as a single step and stops at the next statement 
of the main program. 

• Move to the change function following the procedures described in section 6.15.1, Executing 
[Step In] Command. 

• To step through all statements in the change function at a single step, select [Step Over] from 
the [Debug] menu of the High-performance Embedded Workshop for CPU1, or click the [Step 
Over] button on the toolbar. After that, select [Go] from the [Debug] menu in the High-
performance Embedded Workshop for CPU0, or click on the [Go] button on the toolbar. 

 

 

Figure 6.27   [Step Over] Button 
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Figure 6.28   [High-performance Embedded Workshop] Window (Step Over) 
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6.16 Forced Breaking of Program Executions 

The High-performance Embedded Workshop can force a break in the execution of a program. 

• Cancel all breaks. 

• To execute the remaining sections of the main function, select [Go] from the [Debug] menu in 
the High-performance Embedded Workshop for CPU1, or the [Go] button on the toolbar. After 
that, select [Go] from the [Debug] menu of the High-performance Embedded Workshop for 
CPU0, or click on the [Go] button on the toolbar. 

 

 

Figure 6.29   [Go] Button 

• The program goes into an endless loop.  To force a break in execution, select [Halt] from the 
[Debug] menu of the High-performance Embedded Workshop for CPU1, or click on the 
[STOP] button on the toolbar. Since the [Break] check box under [Synchronization options] of 
the High-performance Embedded Workshop for CPU0 is enabled, the High-performance 
Embedded Workshop for CPU0 will be halted at the same time as that for CPU1. 

 

 

Figure 6.30   [STOP] Button 
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6.17 Break Function 

The emulator has PC and hardware break functions.  With the High-performance Embedded 
Workshop, a PC breakpoint can be set using the [Breakpoint] sheet of the [Event] window, and a 
hardware break condition can be set using the [Event condition] sheet. 

An overview and setting of the break function are described below. 

6.17.1 PC Break Function 

The emulator can set up to 255 PC breakpoints.  Other methods for setting a PC breakpoint than in 
section 6.7, Setting a PC Breakpoint, are described below. 

• Select [Eventpoints] from the [Code] submenu of the [View] menu in the High-performance 
Embedded Workshop for CPU1.  The [Event] window is displayed. 

• Select the [Breakpoint] sheet. 
 

 

Figure 6.31   [Event] Window (Before PC Breakpoint Setting) 
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• Click the [Event] window with the right-hand mouse button and select [Add…] from the 
popup menu. 

• Enter H'00101060 in the [Address] edit box.  
When using the MCU with flash memory, enter H'00101060 in the [Address] edit box. 

 

 

Figure 6.32   [Breakpoint] Dialog Box 

Note: This dialog box differs according to the product.  For the items of each product, refer to 
the online help. 

• Click the [OK] button. 
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The PC breakpoint that has been set is displayed in the [Event] window. 

 

Figure 6.33   [Event] Window (PC Breakpoint Setting) 

Note: The items that can be displayed in this window differ according to the product.  For the 
items that can be displayed, refer to the online help. 

To stop the tutorial program at the PC breakpoint, the following procedure must be executed: 

• Set the program counter and stack pointer values (PC = H’00000800 and R15 = H’FFF90000) 
that were set in section 6.8, Setting Registers, in the [Register] window of the High-
performance Embedded Workshops for CPU0 and CPU1.  Click the [Go] button in the High-
performance Embedded Workshops for CPU0 and CPU1. 
The internal RAM area differs depending on the MCU. Refer to the hardware manual of the 
MCU used. 

• If program execution is failed, reset the device and execute again the procedures above. 
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The program runs, and stops at the set PC breakpoint. 

 

Figure 6.34   [Editor] Window at Execution Stop (PC Break) 
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The [Status] window displays the following contents. 

 

Figure 6.35   Displayed Contents of the [Status] Window (PC Break) 

Note: The items that can be displayed in this window differ according to the product.  For the 
items that can be displayed, refer to the online help. 

6.18     Hardware Break Function 

A method is given below in which the address bus condition is set under Ch1 (IA_OA_DT_CT) as 
hardware break conditions. 

• Select [Eventpoints] from the [Code] submenu of the [View] menu of the High-performance 
Embedded Workshop for CPU1.  The [Event] window is displayed. 

• The PC breakpoint that has been previously set is deleted.  Click the [Event] window with the 
right-hand mouse button and select [Delete All] from the popup menu to cancel all PC 
breakpoints that have been set. 

• To set a Ch1 (IA_OA_DT_CT) , click the [Event condition] tab. 
 
Up to eleven breakpoints can be set independently for the hardware break condition, in the Event 
conditions 1 to 11. In this example, set the hardware break condition for Ch1 (IA_OA_DT_CT) . 

Note: The number of hardware break conditions differs according to the product.  For the 
number that can be specified for each product, refer to the online help. 
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• Select a line of Ch1 (IA_OA_DT_CT) in the [Event] window.  When highlighted, double-click 
this line. 

 

 

Figure 6.36   [High-performance Embedded Workshop] Window ([Ch1 (IA_OA_DT_CT]) 

• The [Ch1 (IA_OA_DT_CT) ] dialog box is displayed. 

• Clear the [Don't care] check box in the [Address] page. 

• Select the [Only program fetched address] radio button and enter H'00101050 as the value 
in the [Address] edit box. 
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Figure 6.37   [Address] Page ([Ch1 (IA_OA_DT_CT)] Dialog Box) 

Note: The items that can be set in this dialog box differ according to the product.  For details on 
the settings for each product, refer to the online help. 
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• Click the [OK] button. 

• The first point display in the State line changes from Disable to Enable. 

• The first point display in the Condition line changes from None to Address = 
H’00101050 (tutorial.cpp/45) pc Core Select: CPU1 Break (CPU1). 

• Set the program counter and stack pointer values (PC = H’00000800 and R15 = H'FFF90000) 
that were set in section 6.8, Setting Registers, in the [Register] window of the High-
performance Embedded Workshops for CPU0 and CPU1. Click on the [Go] buttons of both 
High-performance Embedded Workshops. 
The internal RAM area differs depending on the MCU. Refer to the hardware manual of the 
MCU used. 

• If program execution is failed, reset the device and execute again the procedures above. 
 
The program runs and then stops at the condition specified under Ch1 (IA_OA_DT_CT). 
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Figure 6.38   [Editor] Window at Execution Stop ([Ch1 (IA_OA_DT_CT)] ) 
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The [Status] window displays the following contents. 

 

Figure 6.39   Displayed Contents of the [Status] Window ([Ch1 (IA_OA_DT_CT] ) 

Note: The items that can be displayed in this window differ according to the product.  For the 
items that can be displayed, refer to the online help. 
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6.18.1 Setting the Sequential Break Condition 

The emulator has sequential break functions. 

Set hardware break conditions as follows: 

Ch1 (IA_OA_DT_CT): A break condition is satisfied immediately after address H'00101050 is 
accessed. 

Ch2 (IA_OA_DT_CT): A break condition is satisfied immediately after address H'00101042 is 
accessed. 

Follow the setting method described in the previous section. 

To set these breakpoints as sequential: 

• Select [Combination action (Sequential or PtoP)] from the popup menu by clicking the [Event] 
window with the right-hand mouse button.  The [Combination action (Sequential or PtoP)] 
dialog box will open. 

 

 

Figure 6.40   [Combination action (Sequential or PtoP)] Dialog Box 

Note: The items that can be displayed in this dialog box differ according to the product.  For the 
items that can be displayed, refer to the online help. 

• Select [Break: Ch2-1] and click on the [OK] button. 
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When the setting is completed, the [Event] window will be as shown in figure 6.41. 

 

Figure 6.41   [Event condition] Page 

Soon after set the [Combination action (Sequential or PtoP)], Ch1 (IA_OA_CT) or Ch2 
(IA_OA_DT) will be invalid. Select Ch1 (IA_OA_CT) or Ch2 (IA_OA_DT) individually, and 
click the [Event] window with the right-hand mouse button and select [Enable]. 

Note: The items that can be displayed in this dialog box differ according to the product.  For the 
items that can be displayed, refer to the online help. 

• Set the program counter and stack pointer values (PC = H’00000800 and R15 = H’FFF90000) 
that were set in section 6.8, Setting Registers, in the [Register] windows of the High-
performance Embedded Workshops for CPU0 and CPU1. Click on the [Go] buttons of both 
High-performance Embedded Workshops. 
 

• If program execution is failed, reset the device and execute again the procedures above. 
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The program runs and then stops at the condition specified under Ch1(IA_OA_DT_CT). 

 

Figure 6.42   [Editor] Window at Execution Stop (Sequential Break) 
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The [Status] window displays the following contents. 

 

Figure 6.43   Displayed Contents of the [Status] Window (Sequential Break) 

Note: The items that can be displayed in this window differ according to the product.  For the 
items that can be displayed, refer to the online help. 

• The sequential break conditions that have been previously set are deleted.  Click the [Event] 
window with the right-hand mouse button and select [Delete All] from the popup menu to 
cancel all hardware break conditions that have been set. 

• Select [Combination action (Sequential or PtoP)] from the popup menu by clicking the [Event] 
window with the right-hand mouse button.  The [Combination action (Sequential or PtoP)] 
dialog box will open (figure 6.40). 

• Select the [Don’t care] radio button and click the [OK] button. 
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6.19 Trace Functions 

The emulator has two branch-instruction trace functions. 

• Internal Trace Function 

Refer to section 5.6, Viewing the Trace Information, to see the setting and displayed contents. 

• AUD Trace Function 

This is the large-capacity trace function that is enabled when the AUD pin is connected to the 
emulator. When a set of the branch source and branch destination instructions is one branch, 
the maximum number of events acquired by a trace is 262,144. 

 
Refer to section 5.6, Viewing the Trace Information, to see the setting and displayed contents. 

6.19.1 Displaying the [Trace] Window 

Select [Trace] from the [Code] submenu of the [View] menu of the High-performance Embedded 
Workshop for CPU1.  The result of the acquired trace is displayed. 

 

6.19.2 Internal Trace Function 

The branch source and branch destination information for the latest several branch instructions are 
displayed.   

In the internal trace function, the type of the branch instruction can be specified and acquired.   

The type is specified as follows: 

• Select [Trace] from the [View] menu. 

• Click the [Trace] window with the right-hand mouse button and select [Set…] from the popup 
menu to display the [Acquisition] dialog box. 

 



Section 6   Tutorial 

  Rev. 1.00  Nov. 26, 2007  Page 191 of 230 

                                                                                       REJ10J1766-0100 

 

Figure 6.44   [Acquisition] Dialog Box 
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Note: The items that can be set in this dialog box differ according to the product.  For details on 
the settings for each product, refer to the online help. 

Run the program as shown in the example of section 6.18, Hardware Break Function.  The trace 
results are displayed in the [Trace] window after the program execution is completed. 

 

Figure 6.45   [Trace] Window 

• If necessary, adjust the column widths by dragging borders in the header bar (immediately 
below the title bar). 

 
Note: The type and the amount of information that can be acquired by a trace differ according to 

the product.  For details on the specifications of each product, refer to the online help. 

6.19.3 AUD Trace Function 

This function is available when the AUD pin of the MPU is connected to the emulator. 

The following is the procedure for setting the AUD trace function. 

(1) Setting the trace acquisition mode 

Display the [Trace] window. 

Click the [Trace] window with the right-hand mouse button and select [Acquisition] from the 
popup menu to display the [Trace Acquisition] dialog box. 

Select [AUD function] as the [Trace type].  

The trace acquisition condition is set in the [Trace mode] page. 
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Figure 6.46   [Acquisition] Dialog Box 
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Note: This dialog box cannot be used in a product that does not support the AUD trace function.  
The items that can be set in this window differ according to the product.  For details on the 
settings for each product, refer to the online help. 

The following table shows the options. 

AUD Trace Acquisition Mode 

Type Mode Description 

Realtime trace When the next branch occurs while the trace information is 
being output, all the information may not be output.  The user 
program can be executed in realtime, but some trace 
information will be lost. 

Continuous 
trace occurs 

Non realtime trace When the next branch occurs while the trace information is 
being output, the CPU stops operations until the information 
is output.  The user program is not executed in realtime. 

Trace buffer 
full 

Trace continue This function always overwrites the oldest trace information 
to acquire the latest trace information. 

 Trace stop When the trace buffer becomes full, the trace information is 
no longer acquired.  The user program is continuously 
executed. 

 

AUD Trace Display Range 

                              Type                        Description 

 Start pointer Set the pointer to the start of the region for AUD tracing. The 
default is D′255. 

 End pointer Set the pointer to the end of the region for AUD tracing. The 
default is D′0 

 

Note: The items that can be set in this window differ according to the product.  For details on the 
settings for each product, refer to the online help. 
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(2) Displaying the trace result 

• Run the program as shown in the example of section 6.18, Hardware Break Function.  The 
trace results are displayed in the [Trace] window after the program execution is completed. 

 

 

Figure 6.47   [Trace] Window (Example) 
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6.20 Stack Trace Function 

The emulator uses the information on the stack to display the names of functions in the sequence 
of calls that led to the function to which the program counter is currently pointing. 

Note: This function can be used only when the load module that has the Elf/Dwarf2-type 
debugging information is loaded.  Such load modules are supported in SHC/C++ compiler 
(including OEM and bundle products) V6.0 or later. 

• Double-click the [Event] column in the sort function in the High-performance Embedded 
Workshop for CPU1 and set an Event point. 

 

 

Figure 6.48   [Editor] Window (Hardware Break Setting) 
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• Set the same program counter and stack pointer values (PC = H’00000800 and R15 = 
H’FFF90000) as were set in section 6.8, Setting Registers (again, use the [Register] windows 
in the High-performance Embedded Workshops for CPU0 and CPU1). After that, click on the 
[Go] buttons in the High-performance Embedded Workshops for CPU0 and CPU1. 
The internal RAM area differs according to the MCU. Refer to the hardware manual for the 
MCU in use. 

• If program execution is failed, reset the device and execute again the procedures above. 

• After the break in program execution, select [Stack Trace] from the [Code] submenu of the 
[View] menu to open the [Stack Trace] window. 

 

 

Figure 6.49   [Stack Trace] Window 

Figure 6.49 shows that the position of the program counter is currently at the selected line of the 
sort() function, and that the sort() function is called from the main() function. 

To remove the hardware break, double-click the [Event] column in the sort function again. 

Note: For details on this function, refer to the online help.  
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6.21 Performance Measurement Function 

The emulator has performance measurement functions. 

• Performance measurement function 

This function applies a counter in the MPU to measure the number of times various events 
have occurred and cycle count.  A start and end condition for counting can be set. 

Various items that can be measured differ according to the supported MPU. 
 

6.21.1 Performance Measurement Function 

The following is an example of the use of a counter in the MPU to measure the number of times 
various events have occurred and cycle count. 

(1) Setting method 

Select [Performance Analysis] from the [Performance] submenu of the [View] menu of the High-
performance Embedded Workshop for CPU1. 
When the [Select Performance Analysis Type] dialog box will open, click the [OK] button. 

 

Figure 6.50   [Select Performance Analysis Type] Dialog Box 
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• The [Performance Analysis] window will be displayed. 

• Place the mouse cursor anywhere within this window, click the right-hand mouse button, and 
then select [Set] from the popup menu.  The [Performance Analysis] dialog box will open.  
The events to be measured and measuring conditions can be set in this dialog box. 

 
Note: The items that can be displayed in this dialog box differ according to the product.  For 

details on the settings for each product, refer to the online help. 

After the conditions have been set, clicking the [OK] button and executing the user program will 
display the result of measurement in the [Performance Analysis] window. 

 

Figure 6.51   [Performance Analysis] Window 

Note: The items that can be displayed in this window differ according to the product.  For details 
on the settings for each product, refer to the online help. 
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6.22 Download Function to the Flash Memory Area 

The emulator enables downloading to the external flash memory area.  This function requires a 
program for programming the flash memory (hereinafter referred to as a write module), a program 
for erasing the flash memory (hereinafter referred to as an erase module), and the RAM area for 
downloading and executing these modules. 

Notes: 1. The write and erase modules must be prepared by the user. 

 2. This function is not available depending on the MCU. For such an MCU, the [Loading 
flash memory] page shown in figure 6.52 will not be displayed. 

 
• Interface with write and erase modules and emulator firmware 

The write and erase modules must be branched from the emulator firmware.  To branch from 
the emulator firmware to the write and erase modules, or to return from the write and erase 
module to the emulator firmware, the following conditions must be observed: 

⎯ Describe all the write and erase modules with the assembly language. 

⎯ Save and return all the general register values and control register values before and after 
calling the write or erase module. 

⎯ Return the write or erase module to the calling source after processing. 

⎯ The write and erase module must be a Motorola-type file. 

The module interface must be as follows to pass correctly the information that is required 
for flash memory accessing. 
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Table 6.2   Module Interface 

Module Name Argument Return Value 

Write module R4(L): Write address 

R7(L): Verify option 
0 = no verify, 
1 = verify 

R5(L): Access size 
0x4220 = byte, 
0x5720 = word, 
0x4C20 = longword 

R6(L): Write data 

R0(L): End code 
Normal end = 0, 
Abnormal end = other than 0, 
Verify error = BT 

Erase module R4(L): Access size 
0x4220 = byte, 
0x5720 = word, 
0x4C20 = longword 

None 

Note: The (L) means the longword size. 

 

Note: Write module: The write data for the access size is set to the R6 register.  When the access 
size is word or byte, 0 is set to the upper bits of the R6 register. 
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• Flash memory download method 

For downloading to the flash memory, set the items on the [Loading flash memory] page in the 
[Configuration] dialog box, which is opened from [System…], then [Emulator] from the 
[Setup] menu.  

 

Figure 6.52   [Loading flash memory] Page 
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Table 6.3 shows the options for the [Loading flash memory] page. 

Table 6.3   [Loading flash memory] Page Options 

Option Description 

[Loading flash memory] 
radio button 

Sets Enable for flash memory downloading. 

When Enable is selected, and [File load] is selected from the [File] 
menu for downloading, the write module is always called. 
Enable: Download to the flash memory 
Disable: Not download to the flash memory 

[Erasing flash memory] 
radio button 

Sets Enable for erasing before the flash memory is programmed. 

When Enable is selected, the erase module is called before calling the 
write module. 
Enable: Erase the flash memory 
Disable: Not erase the flash memory 

[File name] edit box Sets the file name of the S-type load module including the write and 
erase modules.  The file that has been set is loaded to the RAM area 
before loading to the flash memory. 
A maximum of 128 characters can be input for the file name. 

[Bus width of flash 
memory] list box 

Sets the bus width of the flash memory. 

[Flash memory erasing 
time] edit box* 

Sets the TIMEOUT value for erasing the flash memory.  Set a larger 
value if erasing requires much time; the default time is three minutes.  
The radix for the input value is decimal.  It becomes hexadecimal by 
adding H’. 

[Entry point] group box Sets the calling destination address or access size of the write and 
erase modules. 

[All erasing module address] edit box: Inputs the calling destination 
address of the erase module. 
[Writing module address] edit box: Inputs the calling destination 
address of the write module. 
[Access size] combo box: Selects the access size of the RAM area 
where the write/erase module is loaded. 

Note: Although the values that can be set are D'1 to D'65535, the TIMEOUT period may be 
extended according to the set value.  Therefore, it is recommended to input the minimum 
value by considering the erasing time of the flash memory in use. 
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• Notes on using the flash memory download function 

The following are notes on downloading to the flash memory. 

⎯ When the flash memory download is enabled, downloading to areas other than the flash 
memory area is disabled. 

⎯ Downloading is only enabled to the flash memory area.  Perform memory write or PC 
break only to the RAM area. 

⎯ When the flash memory erase is enabled, the [Stop] button cannot stop erasing. 

⎯ The area for the write and erase modules must be set in an MMU-disabled space. 
 
• An example of downloading to the flash memory 

The following is an example of downloading to the flash memory manufactured by Intel 
Corporation (type number: G28F640J5-150) that has been mounted on Renesas' SH7751 CPU 
board (type number: HS7751STC01H).  A sample is provided in the \Fmtool folder in the 
installation destination folder.  Create a program that suits the user specifications by referring 
to this sample. 

 
Table 6.4   Board Specifications 

Item Contents 

SDRAM address H'0C000000 to H'0FFFFFFF 

Flash memory address H'00000000 to H'01FFFFFF 

Bus width of flash memory 32 bits 

CPU internal frequency 167 MHz 

Bus frequency 55.7 MHz 

Operating 
environment 

CPU internal module frequency 27.84 MHz 

 Endian Big endian 
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Flash memory 
(32 Mbytes)

A0-A22

SHxxxx

CE0

CE1,2

OE

WE

D0-D7

D8-D15

D0-D7

D8-D15

D0-D7

D8-D15

D0-D7

D8-D15

FPGA

FIA bus buffer

FIA bus buffer

FD bus buffer

A2-A24

CS0

CS2

RD

WE0

D0-D31

GND

0-7

8-15

16-23

24-31

 

Figure 6.53   Flash Memory Wiring 

Table 6.5   Sample Program Specifications 

Item Contents 

RAM area to be used H'0C001000 to H'0C0015BF 

Write module start address H'0C001100 

Erase module start address H'0C001000 

 

• Since the SDRAM is used, the bus controller must be set. 

• Set the options on the [Loading flash memory] page in the [Configuration] dialog box as 
follows: 
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Figure 6.54   [Loading flash memory] Page 

Notes: 1. When the data has already been written in the flash memory, be sure to select [Enable] 
for [Erasing flash memory].  If [Disable] is selected, a verify error occurs. 

 2. When [Erasing flash memory] is selected, it takes about one minute to erase the flash 
memory (in this example). 

• Select the object for downloading to the flash memory area. 
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6.23 What Next? 

This tutorial has described the major features of the emulator and the use of the High-performance 
Embedded Workshop. 

Sophisticated debugging can be carried out by using the emulation functions that the emulator 
offers.  This provides for effective investigation of hardware and software problems by accurately 
isolating and identifying the conditions under which such problems arise. 
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Section 7   Maintenance and Guarantee 

This section describes maintenance, guarantee, repair provisions, and how to request for repair of 
the emulator. 

7.1 User Registration 

When you purchase our product, be sure to register as a user. For user registration, refer to the 
section of ‘User Registration’ (p. iii) of this user's manual. 

7.2 Maintenance 

1. If dust or dirt collects on any equipment of this product, wipe the board dry with a soft cloth. 
Do not use thinner or other solvents because these chemicals can cause the equipment's surface 
coating to separate. 

2. When you do not use this product for a long period, for safety purposes, disconnect the power 
cable from the power supply. 

 

7.3 Guarantee 

If your product becomes faulty within one year after its purchase while being used under good 
conditions by observing ‘IMPORTANT INFORMATION’ described in this user's manual, we will 
repair or replace your faulty product free of charge. Note, however, that if your product's fault is 
raised by any one of the following causes, we will repair it or replace it with new one with extra-
charge: 

• Misuse, abuse, or use under extraordinary conditions 

• Unauthorized repair, remodeling, maintenance, and so on 

• Inadequate user's system or misuse of it 

• Fires, earthquakes, and other unexpected disasters 
 
In the above cases, contact your local distributor. If your product is being leased, consult the 
leasing company or the owner. 
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7.4 Repair Provisions 

7.4.1 Repair with Extra-Charge 

The products elapsed more than one year after purchase can be repaired with extra-charge. 

7.4.2 Replacement with Extra-Charge 

If your product's fault falls in any of the following categories, the fault will be corrected by 
replacing the entire product instead of repair, or you will be advised to purchase new one, 
depending on the severity of the fault. 

• Faulty or broken mechanical parts 

• Flaw, separation, or rust in coated or plated parts 

• Flaw or cracks in plastic parts 

• Faults or breakage caused by improper use or unauthorized repair or modification 

• Heavily damaged electric circuits due to overvoltage, overcurrent or shorting of power supply 

• Cracks in the printed circuit board or burnt-down patterns 

• Wide range of faults that makes replacement less expensive than repair 

• Unlocatable or unidentified faults 
 

7.4.3 Expiration of the Repair Period 

When a period of one year elapses after the model was dropped from production, repairing 
products of the model may become impossible. 

7.4.4 Transportation Fees at Sending Your Product for Repair 

Send your product to us for repair at your expense. 
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7.5 How to Make a Request for Repair 

If your product is found faulty, follow the procedure below to send your product for repair. 

Fill in the Repair Request Sheet included with this product, then send it along with this product for 
repair to your local distributor. Make sure that information in the Repair Request Sheet is written 
in as much detail as possible to facilitate repair. 

CAUTION 
Note on Transporting the Product: 

  When sending your product for repair, use the packing 
box and cushion material supplied with this product when 
delivered to you and specify handling caution for it to be 
handled as precision equipment. If packing of your product is 
not complete, it may be damaged during transportation. When 
you pack your product in a bag, make sure to use conductive 
polyvinyl supplied with this product (usually a blue bag). 
When you use other bags, they may cause a trouble on your 
product because of static electricity. 
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Appendix A   Troubleshooting 

1. I have a text file open in the editor but syntactic color-coding is not being displayed. 

Ensure that you have named the file (i.e. saved it) and that the “Syntax coloring” check box is 
set on the “Editor” tab of the “Options” dialog box, which is launched via [Setup -> 
Options...]. The High-performance Embedded Workshop looks up the filename extension to 
determine the group to which the file belongs and decides whether or not coloring should be 
applied to the file. To view the currently defined filename extensions and file groups, select 
[Project -> File Extensions...] to launch the “File Extensions” dialog box. To view the 
coloring information, select [Setup -> Format] to display the “Color” tab of the “Format” 
dialog box. 

2. I want to change the settings of a tool but the [Tools->Administration…] menu option is not 
selectable. 

[Tools->Administration...] is not selectable while a workspace is open. To open the “Tool 
Administration” dialog box, close the current workspace. 

3. I opened a workspace from my PC, and one of my colleagues opened the same workspace 
simultaneously from another PC. I changed the settings of the workspace and saved it.  My 
colleague saved the workspace after me. I opened the workspace again and found that the 
settings of the workspace differed from those I had made. 

The last settings to be saved are effective. While a workspace is open in the High-performance 
Embedded Workshop, updating of the workspace is within the memory. The settings are not 
saved in a file unless the user intentionally saves the workspace. 

 
In addition to above, refer to FAQs on the emulator and High-performance Embedded Workshop 
on the Renesas web site (www.renesas.com). 
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Appendix B   Menus 

Table B.1 shows GUI menus. 

Table B.1   GUI Menus 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

View Disassembly Ctrl + D 
 

Opens the [Disassembly] 
window. 

 Command Line Ctrl + L 
 

Opens the [Command Line] 
window. 

 TCL toolkit Shift + 
Ctrl + L  

Opens the [Console] window. 

 Workspace Alt + K 
 

Opens the [Workspace] window. 

 Output Alt + U 
 

Opens the [Output] window. 

 Difference   Opens the [Difference] window. 

 CPU Registers Ctrl + R 
 

Opens the [Register] window. 

  Memory… Ctrl + M 
 

Opens the [Memory] window. 

  IO Ctrl + I 
 

Opens the [IO] window. 

  Status Ctrl + U 
 

Opens the [Status] window. 

  Cache Shift + 
Ctrl + C  

Opens the [Cache] window. 

  TLB Shift + 
Ctrl + X  

Opens the [TLB] window. 

 Sym-
bol 

Labels Shift + 
Ctrl + A  

Opens the [Labels] window. 

  Watch Ctrl + W 
 

Opens the [Watch] window. 

  Locals Shift + 
Ctrl + W  

Opens the [Locals] window. 
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Table B.1   GUI Menus (cont) 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

View 
(cont) 

Code Eventpoints Ctrl + E 
 

Opens the [Event] window. 

  Trace Ctrl + T 
 

Opens the [Trace] window. 

  Stack Trace Ctrl + K 
 

Opens the [Stack Trace] window. 

 Gra-
phic 

Image… Shift + 
Ctrl + G  

Opens the [Image] window. 

  Waveform… Shift + 
Ctrl + V  

Opens the [Waveform] window. 

 Per-
form-
ance 

Performance 
Analysis 

Shift + 
Ctrl + P  

Opens the [Performance Analysis] 
window. 

Setup Radix Hexadecimal  
 

Uses a hexadecimal for displaying 
a radix in which the numerical 
values will be displayed and 
entered by default. 

  Decimal  
 

Uses a decimal for displaying a 
radix in which the numerical values 
will be displayed and entered by 
default. 

  Octal  
 

Uses an octal for displaying a radix 
in which the numerical values will 
be displayed and entered by 
default. 

  Binary  
 

Uses a binary for displaying a 
radix in which the numerical values 
will be displayed and entered by 
default. 

 Emu-
lator 

System…  
 

Opens the [Configuration] dialog 
box allowing the user to modify the 
debugging platform settings. 
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Table B.1   GUI Menus (cont) 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

Debug Debug Sessions…   Opens the [Debug Sessions] 
dialog box to list, add, or remove 
the debug session. 

 Debug Settings…   Opens the [Debug Settings] 
dialog box to set the debugging 
conditions or download modules. 

 Reset CPU  
 

Resets the target hardware and 
sets the PC to the reset vector 
address. 

 Go F5 
 

Starts executing the user program 
at the current PC. 

 Reset Go Shift + F5 
 

Resets the target microcomputer 
and executes the user program 
from the reset vector address. 

 Go To Cursor  
 

Starts executing the user program 
at the current PC until the PC 
reaches the address indicated by 
the current text cursor position. 

 Set PC To Cursor  
 

Sets the PC to the address at the 
row of the text cursor. 

 Run…   Launches the [Run Program] 
dialog box allowing the user to 
enter the PC or PC breakpoint 
during executing the user 
program. 

 Step In F11 
 

Executes a block of user program 
before breaking. 

 Step Over F10 
 

Executes a block of user program 
before breaking. If a subroutine 
call is reached, then the 
subroutine will not be entered. 

 Step Out Shift + 
F11  

Executes the user program to 
reach the end of the current 
function. 

 Step…   Launches the [Step Program] 
dialog box allowing the user to 
modify the settings for stepping. 
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Table B.1   GUI Menus (cont) 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

Debug 
(cont) 

Step 
Mode 

Auto   Steps only one source line when 
the [Source] window is active. 
When the [Disassembly] window 
is active, stepping is executed in a 
unit of assembly instructions. 

  Assembly   Executes stepping in a unit of 
assembly instructions. 

  Source   Steps only one source line. 

 Halt Program Esc 
 

Stops the execution of the user 
program. 

 Connect  
 

Connects the debugging platform. 

 Initialize   Disconnects the debugging 
platform and connects it again. 

 Disconnect  
 

Disconnects the debugging 
platform. 

 Download Modules   Downloads the object program. 

 Unload Modules   Unloads the object program. 
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Appendix C   Command-Line Functions 

The emulator supports the commands that can be used in the command-line window. 

For details, refer to the online help. 
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Appendix D   Notes on High-performance Embedded 
Workshop 

1. Note on Moving Source File Position after Creating Load Module 

When the source file is moved after creating the load module, the [Open] dialog box may be 
displayed to specify the source file during the debugging of the created load module.  Select 
the corresponding source file and click the [Open] button. 

2. Source-Level Execution 

⎯ Source file 

Do not display source files that do not correspond to the load module in the program 
window.  For a file having the same name as the source file that corresponds to the load 
module, only its addresses are displayed in the program window.  The file cannot be 
operated in the program window. 

⎯ Step 

Even standard C libraries are executed.  To return to a higher-level function, enter Step 
Out.  In a for statement or a while statement, executing a single step does not move 
execution to the next line.  To move to the next line, execute two steps. 

3. Operation During Accessing Files 

Do not perform other operations during downloading the load module, operating [Verify 
Memory] or [Save Memory] in the [Memory] window, or saving in the [Trace] window 
because this will not allow correct file accessing to be performed. 

4. Watch 

⎯ Local variables at optimization 

Depending on the generated object code, local variables in a C source file that is compiled 
with the optimization option enabled will not be displayed correctly.  Check the generated 
object code by displaying the [Disassembly] window.   
If the allocation area of the specified local variable does not exist, displays as follows. 

  Example: The variable name is asc. 

    asc = ?  - target error 2010 (xxxx) 

⎯ Variable name specification 

When a name other than a variable name, such as a symbol name or function name, is 
specified, no data is displayed. 
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  Example: The function name is main. 

    main =  

5. Line Assembly 

⎯ Input radix 

Regardless of the Radix setting, the default for line assembly input is decimal.  Specify H’ 
or 0x as the radix for a hexadecimal input. 

6. Command Line Interface 

⎯ Batch file 

To display the message “Not currently available” while executing a batch file, enter the 
sleep command.  Adjust the sleep time length which differs according to the operating 
environment. 

Example: To display “Not currently available” during memory_fill 
execution: 

    sleep d’3000 

    memory_fill 0 ffff 0 

⎯ File specification by commands 

The current directory may be altered by file specifications in commands.  It is 
recommended to use absolute paths are recommended to be used to specify the files in a 
command file so that the current directory alteration is not affected. 

Example: FILE_LOAD C:\Hew3\Tools\Renesas\DebugComp\Platform 
\E10A-USBM\Tutorial\Tutorial\Debug_SHxxxx_E10A-USBM_ 
SYSTEM\tutorial.abs 

7. Memory Save During User Program Execution 

Do not execute memory save or verifying during user program execution. 

8. Load of Motorola S-type Files 

This HEW does not support Motorola S-type files with only the CR code (H'0D) at the end of 
each record. Load Motorola S-type files with the CR and LF codes (H'0D0A) at the end of 
each record. 
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9. Note on [Register] Window Operation During Program Execution 

The register value cannot be changed in the [Register] window during program execution. 
Even if the changed value is displayed, the register contents are not changed actually. 

10. Break Functions 

⎯ When the PC breakpoint is set in the internal flash memory area, the program is written to 
the internal flash memory each time the user program is executed.  At this time, note that 
the number of rewritable times will be decreased. 

⎯ BREAKPOINT cancellation 

When the contents of the BREAKPOINT address is modified during user program 
execution, the following message is displayed when the user program stops. 

 BREAKPOINT IS DELETED A=xxxxxxxx 

If the above message is displayed, cancel all BREAKPOINT settings with the [Delete All] 
or [Disable] button in the [Eventpoint] window. 

11. Number of BREAKPOINT and [Stop At] Settings in the [Run...] Menu  

The maximum number of BREAKPOINTs and [Stop At] settings allowed in the [Run...] menu 
is 255.  Therefore, when 255 BREAKPOINTs are set, specification by [Stop At] in the [Run...] 
menu becomes invalid.  Use the BREAKPOINTs and [Stop At] in the [Run...] menu with 255 
or less total settings. 

12. Note on RUN-TIME Display 

The execution time of the user program displayed in the [Status] window is not a correct value 
since the timer in the host computer has been used. 

13. Note on Displaying Timeout error 

If Timeout error is displayed, the emulator cannot communicate with the target 
microcomputer.  Turn off the user system and connect the USB connector of the emulator 
again by using the HEW. 

14. Note on Using the [Run Program] Dialog Box 

When [Run...] is selected from the [Debug] menu to specify the stop address, there is the 
following note: 

⎯ When the breakpoint that has been set as Disable is specified as the stop address, note that 
the breakpoint becomes Enable when the user program stops. 
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15. Memory Access during User Program Execution 

When a memory is accessed from the memory window, etc. during user program execution, 
the user program is resumed after it has stopped in the emulator to access the memory.  
Therefore, realtime emulation cannot be performed.  

The stopping time of the user program is as follows: 

Environment: 
       Host computer: 3 GHz (Pentium® 4)  

       SH7265R: System clock frequency 66.6 MHz 
       JTAG clock: 2.5 MHz 

When a one-byte memory is read from the command-line window, the stopping time will be 
about 20 ms. 

 

 

16. BREAKPOINT Setting for SLEEP Instruction 

When a break is set for the SLEEP instruction, use the Break Condition not the 
BREAKPOINT. 

17. Note on Session Save in the [Configuration] Dialog Box 

The following settings are not saved as a session: 

⎯ JTAG clock in the [General] page 

⎯ Loading flash memory in the [Loading flash memory] page 

18. Scrolling Window During User Program Execution 

Do not scroll the [Memory] and [Disassembly] windows by dragging the scroll box during user 
program execution.  This generates many memory reads causing the user program to stop 
execution until the memory reads have been completed. 

19.  Memory Test Function 

This product does not support the memory test function, which is used by selecting [Test…] 
from the [Memory] menu. 

20. Memory Access during Flash Memory Programming 

During flash memory programming (e.g., user program execution), operation for memory 
accessing such as opening the [Memory] window is not allowed. Values displayed here are 
dummy. Access the memory again after flash memory programming has been completed 

.
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Appendix E   Diagnostic Test Procedure 

For the diagnostic test procedure using the emulator test program, refer to the test program manual 
for the emulator (file name: E10A-USBM TME.PDF) in the CD-R 
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Appendix F   Repair Request Sheet 

Thank you for purchasing the E10A-USB Multi emulator (HS0005KCU04). 

In the event of a malfunction, fill in the repair request sheet on the following pages and send it to 
your distributor. 
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Repair Request Sheet 

To Distributor 

Your company name:  

Person in charge:  

Tel.:  

Item Symptom 

1. Date and time when the 
malfunction occurred 

Month/Day/Year {at system initiation, in system operation} 

*Circle either of items in the braces { }. 

2. Frequency of generation of the 
malfunction 

( ) times in ( ) {day(s), week(s), or month(s)} 

*Enter the appropriate numbers in the parentheses ( ) and 
circle one of the three items in the braces { }. 

3. System configuration when the 
malfunction occurred 

System configuration of the emulator: 

• E10A-USB Multi emulator (HS0005KCU04):  

Serial No.:  

Revision:  

The above items are written on the label for product 
management at the bottom of the emulator unit; the serial 
no. is the five-digit number and the revision is the string of 
letters following the number. 

• Provided CD-R (HS0005KCU04SR):  

Version: V.  

Shown as ‘V.x.xx Release xx’ on the CD-R (x: numeral). 

• Host computer in use:  

Manufacturer:  

Type number:  

OS: (Windows® 2000 or Windows® XP) 
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Item Symptom 

4. Settings when the malfunction 
occurred 

(1) MCU: Type number:  

(2) Operating frequency:       MHz 

5. Failure phenomenon  

6. Error in debugging  

7. Error in the diagnostic program  

8. The High-performance Embedded 
Workshop does not link-up with the 
emulator. 

Content of the error message 

 

For errors other than the above, fill in the box below. 
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